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About this document

The IBM® WebSphere®™ Business Integration Adapter portfolio supplies
integration connectivity for leading e-business technologies, enterprise applications,
legacy, and mainframe systems. The product set includes tools and templates for
customizing, creating, and managing components for business process integration.

This document describes installation, configuration, business object development,
and troubleshooting for the IBM WebSphere Business Integration Adapter for
Enterprise Java Beans Architecture.

Audience

This document is for consultants, developers, and system administrators who
support and manage the WebSphere business integration system at customer sites.

Prerequisites for this document

Users of this document should be familiar with the WebSphere business integration
system, with business object and collaboration development, and with the
Enterprise JavaBeans technology.

Related documents

The complete set of documentation available with this product describes the
features and components common to all WebSphere Business Integration Adapter
installations, and includes reference material on specific components.

You can install related documentation from the following sites:

* For general adapter information; for using adapters with WebSphere message
brokers (WebSphere MQ Integrator, WebSphere MQ Integrator Broker,
WebSphere Business Integration Message Broker); and for using adapters with
WebSphere Application Server:

— |http:/ /www.ibm.com /websphere/integration/wbiadapters /infocenter|

* For using adapters with InterChange Server:

— |http:/ /www.ibm.com /websphere/integration / wicserver /infocenter|

— |http:/ /www.ibm.com /websphere /integration /wbicollaborations/infocenter|

¢ For more information about message brokers (WebSphere MQ Integrator Broker,
WebSphere MQ Integrator, and WebSphere Business Integration Message
Broker):

- Ihttp: / /www.ibm.com/software/integration/mqfamily/library /manualsa/ |

* For more information about WebSphere Application Server:

- Ihttp: / /www.ibm.com/software /webservers/appserv/ library.html|

These sites contain simple directions for downloading, installing, and viewing the
documentation.

Note: Important information about this product may be available in Technical

Support Technotes and Flashes issued after this document was published.
These can be found on the WebSphere Business Integration Support Web
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site, http:/ /www.ibm.com/software/integration/websphere/support/.
Select the component area of interest and browse the Technotes and Flashes
sections. Additional information might also be available in IBM Redbooks at
http:/ /www.redbooks.ibm.com/.

Typographic conventions

vi

This document uses the following conventions:

courier font

bold
italic, italic
blue outline

{1
[]

/,\

%Stext% and $text

ProductDir

Indicates a literal value, such as a command name, filename,
information that you type, or information that the system
prints on the screen.

Indicates a new term the first time that it appears.

Indicates a variable name or a cross-reference.

A blue outline, which is visible only when you view the
manual online, indicates a cross-reference hyperlink. Click
inside the outline to jump to the object of the reference.

In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

In a naming convention, angle brackets surround individual
elements of a name to distinguish them from each other, as
in <server_name><connector_name>tmp.10g.

In this document, backslashes (\) are used as the convention
for directory paths. For UNIX installations, substitute slashes
(/) for backslashes. All product pathnames are relative to the
directory where the connector is installed on your system.
Text within percent (%) signs indicates the value of the
Windows™ text system variable or user variable. The
equivalent notation in a UNIX environment is $text,
indicating the value of the text UNIX environment variable.
Represents the directory where the product is installed.

Adapter for Enterprise Java Beans Architecture User Guide



New in this release

New in version 1.2.x

Beginning in the 1.2.x version of this document, the WebSphere Business
Integration adapter for Enterprise Java Beans will be called the WebSphere
Business Integration adapter for Enterprise Java Beans Architecture.

The ODA supports the generation of hierarchical business objects

New property RetryDuration limits the times that the adapter tries to reconnect
to the application server in the event of an application server downage.

The adapter for EJB Architecture no longer supports InterChange Server version
4.1.1.

Management of the adapter for EJB Architecture by IBM Tivoli License Manager
(ITLM) is now supported.

Support for Java collection classes.

The adapter for EB] Architecture’s and the ODA now supports mapping of
getter/setter methods to business object attributes.

Support for JDK version 1.4.2.

New in version 1.1.x
June 2004:

Beginning with the 1.1.x version, the adapter for EJB is no longer supported on
Solaris 7, so references to that platform version have been deleted from this
guide.

The section [“Mapping attributes: Enterprise JavaBeans (EJB) and business object’]
[on page 32| has been updated with new data type mapping information for the
following EJB constructs:

— Jjava.math.BigDecimal
— Jjava.math.BigInteger

New in version 1.0.x

February 2004:
* Information about locale-dependent data has been moved to the section

[“Adapter environment” on page 1]

+ The section [“Verb processing” on page 7| has been updated with information

about the difference between a blank verb ASI for a remote enterprise bean
versus for a Java object.

The section [“Connector file structure” on page 11| has been updated with
additional names of files that are copied to your system during installation. If
you have already installed the product, you do not need to re-install; the files
were already copied to your system when you previously ran the Installer.

The section [“Configuring the startup file” on page 21| has been updated with a
new sample file name.

* Information about methods and business object attributes in the section

[“Connector business object structure” on page 26| has been updated.
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* Information about business object attributes and their properties, including
application specific information (the AppSpecificInfo property), in the section
[“Attribute-level ASI” on page 29 has been updated.

e Information about running the MusicCart enterprise bean sample files is

provided in the section [‘Running the adapter to invoke sample business objects”]
—

* Information about the CLIENT JARPATH variable of the startup file has been
updated in the section [“Starting the ODA” on page 37|

December 2003:
* Version 1.0.x is the first release of the Adapter for EJB.
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Chapter 1. Overview

This chapter provides an overview of the connector for Enterprise JavaBeans (EJB)
Architecture and contains the following sections:

+ [“Adapter environment”|

* |“Terminology” on page 3

* [“Request processing in the EJB architecture adapter” on page 5|

* |“E]JB transaction support” on page 7|

* |“Security for the EJB architecture adapter” on page 7|

* [“Verb processing” on page 7
¢ [“Data handler processing” on page 8|

The connector for EJB architecture is a run time component of the WebSphere
Business Integration Adapter for Enterprise JavaBeans Architecture. The EJB
architecture adapter includes a connector, message files, configuration tools, and an
Object Discovery Agent (ODA). The connector allows the WebSphere integration
broker to exchange business objects with enterprise beans that have been designed
using the Enterprise JavaBeans (E]JB) architecture and deployed on an application
server. The connector does this by enabling business processes in the broker to
pass data to one or more enterprise bean business methods and receive returned
data. The adapter is unidirectional in that it provides request processing
functionality only. It does not perform event notification.

A connector consists of two components: the connector framework and the
application-specific component. The connector framework, whose code is common
to all connectors, acts as an intermediary between the integration broker and the
application-specific component. The application-specific component contains code
tailored to a particular technology (in this case, the E]JB architecture) or application.
The connector framework provides the following services between the integration
broker and the application-specific component:

* Receives and sends business objects
* Manages the exchange of startup and administrative messages

This document contains information about both the connector framework and the
application-specific component. It refers to both of these components as the
connector.

Adapter environment

Before installing, configuring, and using the adapter, you must understand its
environment requirements. In addition to the text below, hardware and software
requirements are also available in the Techdoc at

http:/ /www.ibm.com/support/docview.wss?uid=swg27006249

* [“Broker compatibility” on page 2|

* [“Adapter standards” on page 2|

* [“Adapter platforms” on page 3

+ |“Adapter dependencies” on page 3|

+ [“Locale-dependent data” on page 3|

© Copyright IBM Corp. 2003, 2005 1



Broker compatibility

The adapter framework that an adapter uses must be compatible with the version
of the integration broker (or brokers) with which the adapter is communicating.
The 1.2.x version of the adapter for Enterprise JavaBeans architecture is supported
on the following versions of the adapter framework and with the following
integration brokers:

* Adapter framework:

— WebSphere Business Integration Adapter Framework, version 2.6.0.3, 2.6.0
* Integration brokers:

— WebSphere InterChange Server, version 4.2.2, 4.3.x

— WebSphere MQ Integrator, version 2.1, 5.0

— WebSphere MQ Integrator Broker, version 2.1.0

— WebSphere Business Integration Message Broker, version 5.0

— WebSphere Application Server Enterprise, version 5.0.2, with WebSphere
Studio Application Developer Integration Edition, version 5.0.1

See Release Notes for any exceptions.

Note: For instructions on installing the integration broker and its prerequisites, see
the following documentation.

For WebSphere InterChange Server (ICS), see the System Installation Guide for
UNIX or for Windows.

For message brokers (WebSphere MQ Integrator Broker, WebSphere MQ
Integrator, and WebSphere Business Integration Message Broker), see
Implementing Adapters with WebSphere Message Brokers, and the installation
documentation for the message broker. Some of this can be found at the
following Web site:

|http: / /www.ibm.com/software/integration /mqfamily /library /manualsa/| |

For WebSphere Application Server, see Implementing Adapters with
WebSphere Application Server and the documentation at

[http:/ /www.ibm.com /software /webservers /appserv /library.html|

Adapter standards

The adapter is written to the Enterprise JavaBeans 2.1 specification and as such is
compatible with a J2EE-compliant application server that is based on this standard,
such as WebSphere Application Server, version 5.x.

The adapter supports entity beans and session beans. Message-driven beans are
not supported in this release.

The adapter is compliant with the Java Authentication and Authorization Service
(JAAS), release 1.0.

For information about EJB software architecture, see
lhttp:/ /java.sun.com /products/ejb /|

2 Adapter for Enterprise Java Beans Architecture User Guide
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Adapter platforms

The adapter runs on the following platforms:
* Windows 2000

e Solaris 8, 9

 HP-UX 11i

o AIX® 52

* Linux RedHat 3.0

Adapter dependencies

The ODA for the EJB architecture adapter requires the j2ee.jar file, which is
delivered with the adapter.

Locale-dependent data

The connector has been internationalized so that it can support delivery of
double-byte character sets going into an E]B interface that also supports
double-byte character sets, and deliver message text in the specified language.
When the connector transfers data from a location that uses one character code to a
location that uses a different code set, it performs character conversion to preserve
the meaning of the data.

The Java run time environment within the Java Virtual Machine (JVM) represents
data in the Unicode character code set. Unicode contains encodings for characters
in most known character code sets (both single-byte and multibyte). Most
components in the WebSphere business integration system are written in Java;
therefore, when data is transferred between most integration components, there is
no need for character conversion.

Terminology

The following terms are used in this guide:

* ASI (Application-Specific Information) Metadata tailored to a particular
application or technology. ASI exists at both the attribute and business object
level of a business object. See also Verb ASI.

* BO (Business Object) A set of attributes that represent a business entity (such as
Employee) and an action on the data (such as a create or update operation).
Components of the WebSphere business integration system use business objects
to exchange information and trigger actions.

* BO (Business Object) handler A connector component that contains methods
that interact with an application and that transforms request business objects
into application operations.

* Deployment descriptor An XML file, packaged in the JAR (Java Archive) file,
that provides structural application assembly information about which classes
make up the beans in the JAR file, how the beans should be deployed, and how
each bean should be managed at runtime. When an enterprise bean is deployed
to an enterprise application server, the deployment descriptor is read and the
properties are displayed for editing. The person deploying the bean can then
modify and add settings as needed. When the deployer is satisfied with the
deployment information, he or she uses it to generate the entire supporting
infrastructure needed to deploy the enterprise bean to the server.

* EJB Container Manages the interactions between a bean and the application
server by providing life cycle management, security, deployment, and runtime
services. This programmatic entity resides on the application server and as such,

Chapter 1. Overview 3



handles caching at the server-side rather than the client-side. The container
isolates the enterprise bean from direct access by client applications. When a
client application invokes a remote method on an enterprise bean, the container
first intercepts the invocation to ensure that persistence, transactions, and
security are applied properly to every operation a client performs on the bean.
When a bean is not being used, the container places it in a pool to be reused by
another client, or possibly wipe it from memory while its remote reference on
the client remains intact, only to bring it back when needed. When the client
invokes a method on the remote reference, the EJB container simply resurrects
the bean to service the request, with the client application being unaware of the
entire process. An enterprise bean cannot function outside of an EJB container.

* EJB home object An object that provides the enterprise bean life cycle
operations—create, remove, find. The EJB home object implements the enterprise
bean’s home interface, and the class for the EJB home object is generated by the
container’s deployment tools. The client uses the Java Naming and Directory
Interface (JNDI) to locate an EJB home object. Then, the client references an EJB
home object to perform life cycle operations on an EJB object.

* Enterprise bean An Enterprise JavaBeans component, that consists of a home
interface, remote interface, and a bean class. The home interface represents the life
cycle methods of the component (create, destroy, find), while the remote
interface represents the business methods of the bean. The bean class
implements the business methods defined in the remote interface, and as such is
the key element of the bean.

Enterprise beans are packaged in a JAR file, deployed to an enterprise
application server, and managed by an EJB container. An EJB JAR file contains
one or more enterprise beans and a deployment descriptor. An enterprise bean
cannot function outside of an EJB container.

* Enterprise bean class Implements an enterprise bean’s business methods.

* Enterprise JavaBeans (EJB) EJB enables rapid and simplified development of
object-oriented, distributed, transactional, secure and portable enterprise-level
Java applications. The E]B specification mandates a programming model; that is,
it mandates conventions or protocols and a set of classes and interfaces which
make up the EJB API. The EJB programming model provides enterprise bean
and server developers with a common platform for development.

* Entity bean A bean that models a business concept that can be expressed as a
noun. Customer, Item, and Vendor are examples of names of entity beans, since
they model real-world objects. These objects are usually persistent records in a
database. See also session bean.

* Foreign key A simple attribute whose value uniquely identifies a child business
object. Typically, this attribute identifies a child business object to its parent by
containing the child’s primary key value. The connector for EJB architecure uses
the foreign key to specify poolable connection objects.

* Home interface Defines the bean’s life cycle methods: methods for creating,
removing, and finding the enterprise bean’s remote interface, as well as home
business methods, which are the business methods that are not specific to a
particular bean instance.

* Java Authentication and Authorization Service (JAAS) A security framework
that enables services to authenticate and enforce access controls based on user
identity. It implements a Java version of the standard Pluggable Authentication
Module (PAM) framework, and supports user-based authorization. JAAS
authorization allows you to grant permissions based not on just what code is
running but also on who is running it.

4 Adapter for Enterprise Java Beans Architecture User Guide



¢ Java Naming and Directory Interface (JNDI) A standard Java extension that
provides a uniform API for accessing a wider range of services. The connector
for EJB architecture uses JNDI to locate enterprise beans deployed on an
enterprise application server. The server is required to support JNDI by
organizing enterprise beans into a directory structure and providing a JNDI
driver, called a service provider, for accessing that directory structure.

* ODA (Object Discovery Agent) A tool that automatically generates a business
object definition by examining specified entities within the application and
“discovering” the elements of these entities that correspond to business object
attributes. When you install the adapter, the ODA is automatically installed.
Business Object Designer provides a graphical user interface to access the ODA
and to work with it interactively.

* Per-call object pool A programmatic entity for storing objects that need to pass
from one method to the next during a single doVerbFor method call. Stored
objects may be objects (child or non-child) or simple attributes.

* Remote interface Defines the bean’s business methods that a client may call: the
methods a bean presents to the outside world to do its work. A remote interface
focuses on the business problem and does not include methods for system-level
operations, such as persistence, security, concurrency or transactions. During
connector processing, the connector accesses the enterprise bean through its
remote object definition or stub.

* Session bean An enterprise bean that is created by a client as an extension of
the client application. As such, a session bean is responsible for managing tasks
and processes for the client, such as calculations or access to a database, and
usually exists only for the duration of a single client-server session. Although a
session bean may be transactional, it is not recoverable should a system crash
occur. Session bean objects can be either stateless or can maintain conversational
state across methods and transactions. If a session bean maintains state, then the
EJB container manages this state if the object must be removed from memory;
however, the session bean object itself must manage its own persistent data. See
also entity bean.

* Verb ASI (application-specific information) For a given verb, the verb ASI
specifies how the connector should process the business object when that verb is
active. The verb ASI contains the name of the method to call to process the
current request business object.

Request processing in the EJB architecture adapter

This section describes how the connector for EJB architecture handles request
processing, as illustrated in [Figure 1 on page 6

The request processing scenario described here assumes that:

* The enterprise beans are deployed on a J2EE-compliant enterprise application
server, such as WebSphere Application Server.

* The application server is installed and running.

e The connector has been initialized, which loads the ProviderURL and
InitialContextFactory connector-specific properties. These properties help to
obtain the JNDI initial context, which is required to initiate the connection to the
EJB server and locate the enterprise bean’s home interface. The properties are
cached and re-used throughout the connector life cycle. For details about
connector-specific properties, see |“Connector-specific properties” on page 14| For
details about how the connector manages security, see [‘Configuring security” onl
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Request processing of EJBs in the adapter Internal processing of EJBs on the application server
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Figure 1. Request processing for the connector for EJB architecture

The connector for EJB architecture processes business object requests in the
following manner.

1. The connector receives a business object request from the integration broker.
The business object contains information about the corresponding enterprise
bean, including its JNDI name and the class name of its home and remote
interfaces.

2. The connector uses its InitialContextFactory and ProviderURL properties to
begin the process of locating and accessing the enterprise beans deployed on
the application server. InitialContext is part of the larger JNDI API supported
by the application server. It is the starting point for any JNDI lookup by a
client (such as the connector). The ProviderURL specifies the service provider,
which is a JNDI driver on the application server used for locating the
enterprise bean’s home interface. The home interface provides methods for
creating or finding the enterprise bean remote interface.

3. After locating the home interface, the connector finds the remote interface,
which defines the enterprise bean business methods that a client (in this case,
the connector) can call.

For entity beans, the connector uses either a creator or finder type method,
depending on which has been implemented by the enterprise bean developer
(the connector knows which one to use based on the metadata in the business
object definition). These methods are defined in the home interface and
invoked by a client to obtain a remote/local interface reference to an enterprise
bean instance.

4. Once the connector has located the remote interface, it can begin to invoke
enterprise bean methods. The parent business object sent by the connector
contains a child business object for each method defined in the remote
interface. The child business object’s attributes are mapped to parameters of the
remote method of the corresponding enterprise beans. Since enterprise beans
are loaded dynamically, its methods are discovered and called through
reflection. The details of this step are as follows:

¢ The connector’s BO Handler checks the verb-level ASI of the parent business
object for one ore more lists of attribute names. A list is a series of ordered,
semi-colon-delimited attribute names.

6 Adapter for Enterprise Java Beans Architecture User Guide



* Each attribute of the parent business object contains a child business object
that represents a method to be invoked on the remote interface. In other
words, the verb ASI is not a list of methods, but a list of attributes, each one
having as a value a child object that represents a method to be invoked.

e The connector executes the methods listed in the verb ASI, in the order in
which they are listed.

5. After the methods are executed and values are returned from the EJB
application server, the connector loads the EJB object data into the business
object.

6. The connector returns the business object with populated values from the EJB
application server to the integration broker.

The connector also returns a message to the integration broker indicating that
the original object request was either successful or unsuccessful (a FAIL status).
If the request was successful, the connector also returns the updated business
object to the broker.

EJB transaction support

Note that the connector does not support transacted invocations of EJB methods. If
a business process requires transactions, create a thin wrapper bean that exposes
one non-transactional method to the connector, but internally invokes the target
EJB methods as part of a transaction in the application server.

Security for the EJB architecture adapter

Although it is an optional feature, when EJB security is configured in the
connector, it requires that the connector provide authentication and access control
data to the application server, before it can access any secure beans deployed on
the server. The connector for EJB architecture uses the Java Authentication and
Authorization Service (JAAS) to implement EJB security.

JAAS is a security framework that enables services to authenticate and enforce
access controls based on user identity. It implements a Java version of the standard
Pluggable Authentication Module (PAM) framework, and supports user-based
authorization. JAAS authorization allows you to grant permissions based not on
just what code is running but also on who is running it.

JAAS authentication is performed in a pluggable fashion. This allows Java
applications to remain independent from underlying authentication technologies,
allowing new or updated authentication technologies to be plugged under an
application without requiring modifications to the application itself.

For details about security, see [“Configuring security” on page 18]

Verb processing

The connector processes business objects passed to it by a broker based on the verb
for each business object.

When the connector framework receives a request from the broker, it calls the
doVerbFor() method of the business-object-handler class associated with the
business object definition of the request business object. The role of the
doVerbFor() method is to determine the verb processing to perform, based on the
active verb of the request business object. It obtains information from the request
business object to build and send requests for operations to the application.

Chapter 1. Overview 7



When the connector framework passes the request business object to doVerbFor(),
this method retrieves the business object ASI and invokes the BO handler, which in
turn reads the verb ASI and translates it into a series of callable functions. The
verb ASI is an ordered list of the methods that need to be called for that verb. The
order in which the calls are made is critical to the successful processing of the
object.

If the verb ASI is blank for a remote enterprise bean, then the BO handler searches
for one creator method (Create()) from the home interface with zero arguments,
calls that, and then invokes the first method with populated parameters. The
attribute-level ASI for the constructor should be method name=create.

If the verb ASI is blank for a Java object, then the BO handler searches for one
constructor and one method with populated parameters. The attribute-level ASI for
the constructor should be method_name=CONSTRUCTOR.

On both a remote enterprise bean and a Java object, only one method can be
populated; otherwise, if multiple methods are populated yet the verb ASI is blank,
the connector logs an error and returns a FAIL code. For details about error
processing, see [“Error handling” on page 51 For details about verb ASI, see
[ASI” on page 28

The connector does not support any specific verbs, but using the ODA, the user
can configure custom verbs. The standard, pre-existing verbs are Create, Retrieve,
Update, and Delete. These can be given whatever semantic meaning you provide
through the Object Discovery Agent (ODA) running in Business Object Designer.
For details about using the ODA to assign a method call sequence to a verb, see
[Chapter 5, “Creating and modifying business objects,” on page 37

Data handler processing

Using a data handler is optional. If you have designed a data handler into your
connector architecture, the connector requires access to any data handler classes
needed to convert business object values to enterprise bean parameters (as
specified in the EJB ASI). An enterprise bean method can take an XML, EDI or
other WBI data handler-supported document as an argument to a remote EJB
method.

When the connector receives a business object, it will evaluate the business object
ASI to determine if the business object needs to be converted into data using the
data handler. The business object ASI for a data handler-supported message should
contain the value object_type=dataHandlerObject; mime_type=<text_value> where
<text_value> is the appropriate mime-type defined for the data handler (as
specified in the data handler meta-object) that the adapter should use to convert
the data.

If the connector finds a method business object with a data handler-supported
document as a parameter, then the connector calls the data handler to convert the
business object to the corresponding document, and then invokes a remote
enterprise bean method by passing the document generated by the data handler as
an argument to the method. Similarly if a method returns a document that must be
processed using the data handler, the connector converts the String returned by the
method into a business object using data handler values. For example, if an
enterprise bean method returns an XML or EDI document, the data handler must
be invoked to convert it into a child business object.
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To support a data handler, you must configure the DataHandlerConfigMO
connector-specific property. For details about this and other connector-specific
properties, see [‘Connector-specific properties” on page 14| For details about
developing a data handler, see the Data Handler Guide.
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Chapter 2. Installing the adapter

This chapter describes how to install the connector and contains the following
sections:

+ [“Overview of installation tasks”|

e |“Connector file structure”

» [“Post-installation tasks” on page 12|

Overview of installation tasks

To install the adapter for EJB, you must confirm that the necessary adapter
prerequisites exist in your environment, install the integration broker, and run the
adapter installation.

Confirm adapter prerequisites

Before you install the adapter, confirm that all the environment prerequisites for
installing and running the adapter are on your system. For details, see
fenvironment” on page 1)

Install the integration broker

Installing the integration broker, a task that includes installing the WebSphere
business integration system and starting the broker, is described in the
documentation for your broker. For details about the brokers that the connector for
EJB supports, see|”Broker compatibility” on page 2]

For details about installing the broker, see the appropriate implementation
documentation of the broker you are using.

Install the adapter for EJB and related files

For information on installing WebSphere Business Integration adapter products,
refer to the Installing WebSphere Business Integration Adapters guide located in the
WebSphere Business Integration Adapters Infocenter at the following site:

http:/ /www.ibm.com/websphere/integration/wbiadapters/library/infocenter

Connector file structure

The Installer copies the standard files associated with the connector into your
system. It installs the connector into the ProductDir\connectors\EJB directory, and
adds a shortcut for the connector to the Start menu. Note that ProductDir
represents the directory where the connector is installed.

describes the file structure used by the connector, and shows the files that
are automatically installed when you choose to install the connector through the
Installer.

Table 1. File structure for the connector

Subdirectory of ProductDir Description
\connectors\EJB\BIA_EJB. jar Contains classes used by the EJB connector only
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Table 1. File structure for the connector (continued)

Subdirectory of ProductDir
\connectors\EJB\start EJB.bat

\connectors\EJB\start_EJB.sh
\connectors\messages\BIA_EJBConnector.txt
\connectors\EJB\samples\BIA_EJBConnector.cfg

\connectors\EJB\samples\BIA PortConnector.cfg

\connectors\EJB\samples\Samp1eBOs\

\connectors\EJB\samples\SampleMusicCartEJB\src

\connectors\EJB\samples\SampleMusicCartEJB\
BIA_MusicBeanSample.jar

\repository\EJB\EJBConnectorTemplate
\connectors\EJB\dependencies\j2ee.jar
\ODA\EJB\BIA_EJBODA. jar
\ODA\EJB\start_EJBODA.bat
\ODA\EJB\start EJBODA.sh
\ODA\messages\BIA EJBODAAgent.txt
\ODA\messages\BIA_EJBODAAgent_de DE.txt
\ODA\messages\BIA_EJBODAAgent_en_US.txt
\ODA\messages\BIA_EJBODAAgent_es_ES.txt
\ODA\messages\BIA_EJBODAAgent_fr_FR.txt
\ODA\messages\BIA_EJBODAAgent_it_ IT.txt
\ODA\messages\BIA_EJBODAAgent_ja_JP.txt
\ODA\messages\BIA_EJBODAAgent_ko_KR.txt
\ODA\messages\BIA EJBODAAgent pt BR.txt

\ODA\messages\BIA_EJBODAAgent_zh_CN.txt

\ODA\messages\BIA_EJBODAAgent_zh_TW.txt

Description

The startup script for the generic connector
(Windows 2000)

The startup script for the generic connector (Unix)
Message file for the connector

Sample EJB connector configuration file. For details
about using this file, see [‘Running the adapter to|
[invoke sample business objects” on page 33.|

Sample Port connector configuration file. For details
about using this file, see ['Running the adapter to|
[invoke sample business objects” on page 33|

Sample business object definitions. For details about
using these files, see [“Running the adapter to invoke]
[sample business objects” on page 33/

The EJB source files for the sample beans. For details
about using the samples, see[“Running the adapter]
lto invoke sample business objects” on page 33.|

The EJB JAR file that contains the enterprise beans
you deploy to the application server when running
the sample files. For details about using the samples,
see [‘Running the adapter to invoke sample business|
[objects” on page 33|

Template file for the connector definition.

A JAR file required by the EJB ODA.

The EJB ODA

The ODA startup file (Windows 2000)

The ODA startup file (Unix)

Message file for the ODA

Message file for the ODA (German text strings)
Message file for the ODA (US English text strings)
Message file for the ODA (Spanish text strings)
Message file for the ODA (French text strings)
Message file for the ODA (Italian text strings)
Message file for the ODA (Japanese text strings)
Message file for the ODA (Korean text strings)
Message file for the ODA (Portuguese Brazil -text
strings)

Message file for the ODA (Simplified Chinese text
strings)

Message file for the ODA (Traditional Chinese text
strings)

Note: All product pathnames are relative to the directory where the product is

installed on your system.

Post-installation tasks

After installing the adapter, you must configure it before you can run it. For

details, see [Chapter 3, “Configuring the adapter,” on page 13
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Chapter 3. Configuring the adapter

This chapter describes how to configure the adapter and contains the following
sections:

+ [“Overview of configuration tasks”|

* |“Configuring the connector”

» [“Configuring security” on page 18|

* [“Creating multiple connector instances” on page 20|

« |“Configuring the startup file” on page 21|

4

* [“Starting the connector” on page 22

. "’Stopping the connector” on page 2§|

« |[“Using log and trace files” on page 23|

Overview of configuration tasks

After installation and before startup, you must configure the connector and
configure your business objects.

* Configure the connector: Configuring the connector includes setting up and
configuring the connector. For details, see [“Configuring the connector.”|

e Configure the business objects: You configure business objects through an ODA
(Object Discovery Agent). The ODA enables you to generate business object
definitions. A business object definition is a template for a business object. The
ODA examines specified application objects, “discovers” the elements of those
objects that correspond to business object attributes, and generates business
object definitions to represent the information. Business Object Designer
provides a graphical interface to access the Object Discovery Agent and to work
with it interactively

For details about using the ODA, see [Chapter 5, “Creating and modifying]|
[business objects,” on page 37

Configuring the connector

Connectors have two types of configuration properties: standard configuration
properties and connector-specific configuration properties. You must set the values
of these properties using Connector Configurator before running the connector. For
further information, see[Appendix B, “Connector Configurator,” on page 79.|

A connector obtains its configuration values at startup. During a run time session,
you may want to change the values of one or more connector properties. Changes
to some connector configuration properties, such as AgentTracelevel, take effect
immediately. Changes to other connector properties require connector component
restart or system restart. To determine whether a property is dynamic (taking effect
immediately) or static (requiring either connector component restart or system
restart), refer to the Update Method column in the Connector Properties window
of the System Manager.
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Standard connector properties

Standard connector configuration properties provide information that all
connectors use. See|Appendix A, “Standard configuration properties for]
fconnectors,” on page 55| for documentation of these properties.

Note that although the following properties are listed in [Appendix A, “Standard|
konfiguration properties for connectors,” on page 55,| the connector for EJB does not
use these properties:

e DuplicateEvent Elimination
Pol11EndTime

* PollFrequency
Pol1StartTime

Also, note issues with the following properties:

Locale: Because this connector has been internationalized, you can change the
value of the Locale property

ApplicationName: You must provide a value for the ApplicationName
configuration property before running the connector.

Connector-specific properties

Connector-specific configuration properties provide information needed by the
connector at run time. These properties also provide a way for you to change static
information or logic within the connector without having to recode and rebuild it.

To configure connector-specific properties, use Connector Configurator. Click the
Application Config Properties tab to add or modify configuration properties. For
more information, see |Appendix B, “Connector Configurator,” on page 79/

lists the connector-specific configuration properties, along with their
descriptions and possible values. Note that these properties are all non-hierarchical
Strings. See the sections that follow for details about the properties, including an
image of the properties in [Figure 2 on page 16

Table 2. Connector-specific configuration properties

Name

Possible values Default value

[InitialContextFactory]|

The class name of the | com.ibmwebsphere.naming.WsnInitialContextFactory

initial context factory.

ProviderURL

The URL of the JNDI
service provider. The
service provider is a
driver, on the
application server, that
provides access to the
directories in which the
enterprise beans are
stored on the server.

corbaloc:iiop:localhost:2809

[DataHandlerConfigMO)J

The data handler
meta-object. Used to
support a data handler,
if you have defined one
for the connector.

MO_DataHandTer_Default
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Table 2. Connector-specific configuration properties (continued)

Name Possible values Default value
[LoginConfiguration| The name of the The default value is determined by your application server.
LoginModule class for |For WebSphere Application Server, the class is WSLogin.
JAAS security.
This property can only be used if your application server
provides JAAS support, and you choose to implement secure
access beans.
[CallBackHandlerClass| The user-implemented | For WebSphere Application Server, the class is
CallBackHandler com.ibm.websphere.security.auth.callback.
interface used for JAAS [WSCallbackHandTerImpl
security.
This property can only be used if your application server
provides JAAS support and you choose to implement secure
access beans.
[JAASUserName| The JAAS security user | None
name.
Configure this property only if your application server
provides JAAS support and you choose to implement secure
access beans.
[JAASPassword| The JAAS security None
password.
Configure this property only if your application server
provides JAAS support and you choose to implement secure
access beans.
[JAASRealm| The JAAS security None
realm name.
Configure this property only if your application server
provides JAAS support and you choose to implement secure
access beans.
[RetryDuration| A number value (in None.
seconds)
Configure this property to limit the number of times that the
adapter attempts to reconnect to the application server in the
event of a failure. If this property is not set, the adapter will
repeatedly try to reconnect to the application server until the
application server becomes available.

[Figure 2 on page 16| illustrates the hierarchical relationship of the connector-specific

properties.
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[ Connector properties ]

_[ InitialContextFactory ]

_[ ProviderURL ]

_[ DataHandlerConfigMO ]

—[ LoginConfiguration ]

_{ CallBackHandlerClass ]

—[ JAASUserName ]

_[ JAASPassword ]

_[ JAASRealm ]

Figure 2. Hierarchy of connector-specific properties

InitialContextFactory

The class name of the initial context factory. InitialContext, a JNDI interface
required for initiating the connection to the enterprise application server and
locating the enterprise bean’s home interface, is the starting point of any client
lookup of an enterprise bean. The connector uses the InitialContextFactory
property, along with the ProviderURL property, to obtain the JNDI initial context.

ProviderURL

The URL of the JNDI provider. JNDI enables the connector to access the enterprise
beans by name.The connector uses this URL to connect remotely to the JNDI server
running within the E]JB server. After connecting to the E]JB server, the connector can
locate the home interface of the enterprise bean.

DataHandlerConfigMO

The name of the top-level data handler meta-object. If you have designed a data
handler into your connector architecture, the connector requires access to any data
handler classes needed to convert business object values to enterprise bean
parameters (as specified in the EJB ASI). An enterprise bean method can take an
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XML, EDI or other WBI data handler-supported document as an argument to a
remote EJB method. If the connector finds a method business object with a data
handler-supported document as a parameter, then the connector calls the data
handler to convert the business object to the corresponding document, and then
invokes a remote enterprise bean method by passing the document generated by
the data handler as an argument to the method.

If this property is not filled in, the connector cannot find the meta-object, which it
needs to invoke the appropriate data handler. For information about using a data
handler with the connector, see [“Data handler processing” on page 8|

LoginConfiguration

The class that implements the LoginModule interface of the authentication
technology provider. The authentication technology provider implements the
LoginModule to provide a particular kind of authentication via a pleadable module,
without requiring any modifications to the application itself. Typically, the
LoginConfiguration and LoginModule implementation are provided in the
application server’s login class. If your application server supports secure access
beans using JAAS, and you choose to implement this service for EJB security, set
this property to the name of the LoginModule class of your application server.

For JAAS-compliant application servers, the connector enables the authentication
process by instantiating a LoginContext object, which specifies the LoginModules
that will handle JAAS authentication. During authentication of the client, the
LoginModule prompts for and verifies the username and password, defined in the
JAASUserName and JAASPassword properties.

Although JAAS is not a requirement of the connector, if you specify a value in the
LoginConfiguration property, the connector assumes you are implementing bean
security, in which case the CallBackHandlerClass, JAASUserName, JAASPassword, and
JAASRealm properties are all required.

For details about configuring security, see [’Configuring security” on page 18 and
[“Security for the EJB architecture adapter” on page 7.|

CallBackHandlerClass

A JAAS interface, determined by the application server, that enables a client to
pass authentication data to the application server. This interface implements a
CallBack handler that is passed to the underlying security services so that they can
interact with the application to retrieve from the client (in this case, the connector)
certain authentication data, such as username and password. The LoginModule uses
the CallBack handler to communicate with the client to obtain the requested
authentication data. Username and password for the connector are defined in the
JAASUserName and JAASPassword properties.

If your application server supports secure access beans using JAAS, and you
choose to implement this service for EJB security, set this value to the
user-implemented CallBackHandler interface.

Although JAAS is not a requirement of the connector, if you specify a value in the
LoginConfiguration property, the connector assumes you are implementing bean
security, in which case the CallBackHandlerClass, JAASUserName, JAASPassword, and
JAASRealm properties are all required.

For details about configuring security, see [‘Configuring security” on page 18 and
[“Security for the EJB architecture adapter” on page 7.|
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JAASUserName

If your application server supports secure access beans using JAAS, and you
choose to implement this service for E]JB security, set this value to the JAAS
security user name configured on your application server.

Although, JAAS is not a requirement of the connector, to properly configure
security using JAAS, you must specify values in the JAASUserName,
LoginConfiguration, CallBackHandlerClass, JAASPassword, and JAASRealm
properties.

For details about configuring security, see |”Conﬁguring security’1 and |”Security fod
the EJB architecture adapter” on page 7

JAASPassword

If your application server supports secure access beans using JAAS, and you
choose to implement this service for EJB security, set this value to the JAAS
security password configured on your application server.

Although, JAAS is not a requirement of the connector, to properly configure
security using JAAS, you must specify values in the JAASPassword,
LoginConfiguration, CallBackHandlerClass, JAASUserName, and JAASRealm
properties.

For details about configuring security, see [“Configuring security”] and [“Security for]
{the EJB architecture adapter” on page 7

JAASRealm

If your application server supports secure access beans using JAAS, and you
choose to implement this service for EJB security, set this value to the JAAS
security realm name. A realm is a JAAS mapping of one or more User Groups to a
set of privileges or permissions.

Although, JAAS is not a requirement of the connector, to properly configure
security using JAAS, you must specify values in the JAASRealm,
LoginConfiguration, Cal1BackHandlerClass, JAASUserName, and JAASPassword
properties.

For details about configuring security, see [“Configuring security”] and [“Security for]
fthe EJB architecture adapter” on page 7

RetryDuration

RetryDuration indicates, in seconds, the time for which the adapter will retry to
connect with an unresponsive Application server. By default, the adapter for EJB
architecture will repeatedly attempt to reconnect with an unresponsive Application
server until the application server comes back up.

Configuring security

EJB security in the connector is optional, and only available if the application
server on which the enterprise beans are deployed supports secure beans and the
security protocol you choose. If you do enable security, it requires that the user (in
this case, the connector) provide authentication data to the application server to
access any deployed beans. Security can be enabled in the EJB connector using the
Java Authentication and Authorization Service (JAAS) only if your application
server supports this security technology.
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Assigning method permissions to security roles

The connector relies on access control to ensure that users only access resources for
which they have been given permission. Access control applies security policies
that regulate what a specific user can and cannot do within a system. The security
roles for the enterprise beans in the EJB JAR file specify the methods of the home
and remote interfaces that each security role is allowed to invoke. The deployment
descriptor file includes tags that declare which logical roles are allowed to access
which bean methods at runtime.

The following sample code illustrates how security roles are assigned method
permissions in the deployment descriptor. Notice that for each role listed in the
deployment descriptor, the methods that can be invoked are grouped by bean
name.

<method-permission>
<role-name>payroll_department</role-name>
<method>
<ejb-name>EmployeeService</ejb-name>
<method-name>*</method-name>
</method>
</method-permission>
<method-permission>
<role-name>employee</role-name>
<method>
<ejb-name>AardvarkPayroll</ejb-name>
<method-name>findByPrimaryKey</method-name>
</method>
<method>
<ejb-name>AardvarkPayroll</ejb-name>
<method-name>getEmployeeInfo</method-name>
</method>
<method>
<ejb-name>AardvarkPayrol1</ejb-name>
<method-name>updateEmployeeInfo</method-name>
</method>
</method-permission>
<method-permission>

Using the Java Authentication and Authorization Service
(JAAS)

If your application server supports the Java Authentication and Authorization
Service (JAAS), you can use it to implement EJB security using this service. When
the user or client (in this case, the connector) attempts to access a secure bean
deployed on an application server, JAAS verifies the user and that user’s
permissions. In doing so, JAAS provides an additional level of security to the
application server on which an enterprise bean is deployed. JAAS requires
specifying a LoginContext, LoginModule, and other J2EE classes that describe the
basic methods used to authenticate a client. For additional information about these
classes, see|“LoginConfiguration” on page 17.|

Since the connector for EJB acts as a client of the server, when security is enabled
in the E]JB environment, the connector must provide user authentication data in the
form of a user ID (JAASUserName configuration property of the connector) and
password (JAASPassword configuration property). The EJB container examines the
identity or role passed by the connector, and compares it with the list of identity
objects associated with the method as defined in the deployment descriptor. If the
caller identity from the connector matches a caller identity associated with the
method, then the method can be invoked.

Chapter 3. Configuring the adapter 19



Authentication validates the identity of the user (in this case, the connector). Once
the user has successfully passed through the authentication system, it is free to
access and invoke the methods for which it has permissions.

The connector properties that control EJB security using JAAS are
LoginConfiguration, CallBackHandlerClass, JAASUserName, JAASPassword, and
JAASRealm. The values you enter in these properties are entirely dependent on your
application server. For details about how the connector uses these properties, see
[“Connector-specific properties” on page 14| For details about the values to enter in
the properties, see your application server documentation.

Configuring JAAS in the connector startup file
For the connector to work with JAAS, you must make the following changes to the
connector startup file (start_EJB.bat or start_EJB.sh):

* Enter the following command in the startup file to specify the JAAS
configuration file name and location. This command should appear as one of the
last lines in the file.

-Djava.security.auth.login.config=1login.conf

In the sample command provided here, the JAAS configuration file has the name
Togin.conf; however, this name varies according to the application server
environment. For details about the JAAS configuration file name and location for
your environment, see your application server documentation.

* Uncomment the SECURITY_SETTINGS section in the connector startup file to use
the JAAS API with the connector.

Note that the JAAS API is available in the jaas.jar file provided by any
EJB-supported application server. Make sure to reference jaas.jar in the
classpath of the connector.

Creating multiple connector instances

Creating multiple instances of a connector is in many ways the same as creating a
custom connector. You can set your system up to create and run multiple instances
of a connector by following the steps below. You must:

* Create a new directory for the connector instance
* Make sure you have the requisite business object definitions
* Create a new connector definition file

* Create a new start-up script

Create a new directory

You must create a connector directory for each connector instance. This connector
directory should be named:

ProductDir\connectors\connectorinstance
where connectorInstance uniquely identifies the connector instance.

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file, create
this directory and store the file here:

ProductDir\repository\connectorInstance

Create business object definitions
If the business object definitions for each connector instance do not already exist
within the project, you must create them.
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1. If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer to
import them. You can copy any of the files for the initial connector. Just rename
them if you make changes to them.

2. Files for the initial connector should reside in the following directory:
ProductDir\repository\initialConnectorInstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

Create a connector definition
You create a configuration file (connector definition) for the connector instance in
Connector Configurator. To do so:

1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Create a start-up script
To create a startup script:

1. Copy the initial connector’s startup script and name it to include the name of
the connector directory:

dirname

2. Put this startup script in the connector directory you created in

[directory” on page 20.|

3. Create a startup script shortcut (Windows only).

4. Copy the initial connector’s shortcut text and change the name of the initial
connector (in the command line) to match the name of the new connector
instance.

You can now run both instances of the connector on your integration server at the
same time.

For more information on creating custom connectors, refer to the Connector
Development Guide for C++ or for Java.

Configuring the startup file

Before you start the connector for EJB, you must configure the connector startup
file.

To complete the configuration of the connector for Windows platforms, you must
modify the start_EJB.bat file:

1. Open the start_EJB.bat file.

2. Scroll to the section beginning with “SET JCLASSES..."

3. Edit the JCLASSES variable to point to the JAR file created by the ODA. For
example, if the JAR file created by the ODA is
c:\WebSphereAdapters\connectors\EJB\SampleBeans. jar, then set the JCLASSES
variable to: JCLASSES=. ;%J_ CLASSES%;c:\WebSphereAdapters\connectors\EJB\
SampleBeans.jar
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Starting the connector

A connector must be explicitly started using its connector start-up script. The
startup script should reside in the connector’s runtime directory:

ProductDir\connectors\connName

where connName identifies the connector. The name of the startup script depends
on the operating-system platform, as shows.

Table 3. Startup scripts for a connector

Operating system Startup script
UNIX-based systems connector_manager_connName
Windows start_connName .bat

You can invoke the connector startup script in any of the following ways:
* On Windows systems, from the Start menu

Select Programs>IBM WebSphere Business Integration
Adapters>Adapters>Connectors. By default, the program name is “IBM
WebSphere Business Integration Adapters”. However, it can be customized.
Alternatively, you can create a desktop shortcut to your connector.

* From the command line
— On Windows systems:
start_connName connName brokerName [-cconfigFile ]
— On UNIX-based systems:
connector_manager_connName -start

where connName is the name of the connector and brokerName identifies your
integration broker, as follows:

— For WebSphere InterChange Server, specify for brokerName the name of the
ICS instance.

— For WebSphere message brokers (WebSphere MQ Integrator, WebSphere MQ
Integrator Broker, or WebSphere Business Integration Message Broker) or
WebSphere Application Server, specify for brokerName a string that identifies
the broker.

Note: For a WebSphere message broker or WebSphere Application Server on a
Windows system, you must include the -c option followed by the name of
the connector configuration file. For ICS, the -c is optional.

* From Adapter Monitor (WebSphere Business Integration Adapters product only),
which is launched when you start System Manager

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

* From System Monitor (WebSphere InterChange Server product only)

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

For more information on how to start a connector, including the command-line
startup options, refer to one of the following documents:

¢ For WebSphere InterChange Server, refer to the System Administration Guide.

* For WebSphere message brokers, refer to Implementing Adapters with WebSphere
Message Brokers.
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* For WebSphere Application Server, refer to Implementing Adapters with WebSphere
Application Server.

Stopping the connector

The way to stop a connector depends on the way that the connector was started,
as follows:

* If you started the connector from the command line, with its connector startup
script:

— On Windows systems, invoking the startup script creates a separate “console”
window for the connector. In this window, type “Q” and press Enter to stop
the connector.

— On UNIX-based systems, connectors run in the background so they have no
separate window. Instead, run the following command to stop the connector:

connector_manager_connName -stop
where connName is the name of the connector.

* From Adapter Monitor (WebSphere Business Integration Adapters product only),
which is launched when you start System Manager

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

* From System Monitor (WebSphere InterChange Server product only)

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

Using log and trace files

The connector components provide several levels of message logging and tracing.
The connector uses the adapter framework to log error, informational, and trace
messages. Error and informational messages are recorded in the log file, and trace
messages and their corresponding trace levels (0 to 5) are recorded in a trace file.
For details about logging and trace levels, see [Chapter 6, “Troubleshooting and|
ferror handling,” on page 51)

You configure both the log and trace file names, as well as the trace level, in
Connector Configurator. For details about this tool, see[Appendix B, “Connector]
[Configurator,” on page 79.|

Note that the ODA has no logging capability. Error messages are sent directly to
the user interface. Trace files and the trace level are configured in Business Object
Designer. The process is described in[‘Configure the agent” on page 38 The ODA
trace levels are the same as the connector trace levels, defined in|[“Tracing” on pagd
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Chapter 4. Understanding business objects

This chapter describes the structure of business objects, how the connector
processes the business objects, and the assumptions the connector makes about
them.

The chapter contains the following sections:

» |"Defining metadata”|

+ [“Connector business object structure” on page 26|

* |"Mapping attributes: Enterprise JavaBeans (EJB) and business object” on page 32|

G

* [“Running the adapter to invoke sample business objects” on page 33

. "’Generating business objects” on page 36|

Defining metadata

The connector for EJB is metadata-driven. In the WebSphere business integration
system, metadata is defined as application-specific information that describes the
data structures of an object. The metadata is used to construct business object
definitions, which the connector uses at run time to build business objects.

After installing the connector, but before you can run it, you must create the
business objects definitions. The business objects that the connector processes can
have any name allowed by the integration broker. For information about naming
conventions, see Naming Components Guide.

A metadata-driven connector handles each business object that it supports
according to the metadata encoded in the business object definition. This enables
the connector to handle new or modified business object definitions without
requiring modifications to the code. New objects can be created through the Object
Discovery Agent (ODA) in Business Object Designer. To modify an existing object,
use Business Object Designer directly (without going through the ODA).

Application-specific metadata includes the structure of the business object and the
settings of its attribute properties. Actual data values for each business object are
conveyed in message objects at run time.

The connector makes assumptions about the structure of its supported business
objects, the relationships between parent and child business objects, and the format
of the data. It is important that the structure of the business object exactly match
the structure defined for the corresponding enterprise bean or the connector will
not be able to process business objects correctly.

If you need to make changes to the business object structure, make them to the
corresponding enterprise bean and then export the changes to the JAR file for

input into the ODA.

For more information on modifying business object definitions, see WebSphere
Business Integration Adapters Business Object Development Guide.
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Connector business object structure

The connector processes business objects used by enterprise beans. This section
describes the key concepts related to the structure of business objects processed by
the EJB connector.

Methods

For each method defined in a Java class file, the ODA creates an attribute in the
business object (for more information, see [‘Attributes”|and [“ Attribute-level ASI’]

b page 29

The type of the attribute that the ODA creates from a method is a child business
object containing further attributes that represent method parameters and return
types. These attributes appear in the exact same order as the parameters of the EJB
method. The Return_Value attribute (not used if the method being defined is of
type void) always appears last in the order of arguments, and represents the result
of the EJB method call. Child business object attributes can be simple type or object
type (complex), depending on the type of the method parameter or return value.
The application specific information (ASI) for such attributes contains the exposed
remote method name. For details about attribute ASI, see [“Attribute-level ASI” on|

The E]JB connector requires the business object to have a child business object that
maps to a creator method, which is obtained from the list of home interface creator
methods, and one or more business object methods that are obtained from the list
of remote interface methods.

When a remote method takes java objects as an argument or a return type, and the
java objects contain multiple getter/setter methods, the ODA can be used to map
the getter/setter methods to attributes instead of creating a child business object
for each getter/setter method individually.

Note that all non-alphanumeric characters in a property or method name are
replaced in the corresponding business object name with an underscore character

Q).
Attributes

For each public member variable, attribute, and method parameter in an enterprise
bean method that has been defined in a Java class file, a corresponding business
object attribute is generated by the ODA. The JAR file, which contains the
interfaces, is used by the ODA to create business object definitions that map to
remote and local enterprise beans.

If an attribute in the bean class is not a simple attribute, but instead is an object,
then the business object (BO) attribute maps to a child object whose definition
matches the corresponding Java class or EJB interface.

Business objects can be flat or hierarchical. A flat business object only contains
simple attributes, that is, attributes that represent a single value (such as a string)
and do not point to child business objects. A hierarchical business object contains
both simple attributes and child business objects or arrays of child business objects
that contain attribute values.

A cardinality 1 container object, or single-cardinality relationship, occurs when an
attribute in a parent business object contains a single child business object. In this
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case, the child business object represents a collection that can contain only one
record. The attribute type is the child business object.

A cardinality n container object, or multiple-cardinality relationship, occurs when
an attribute in the parent business object contains an array of child business
objects. In this case, the child business object represents a collection that can
contain multiple records. The attribute type is the same as that of the array of child
business objects.

For additional information about business object attributes, see [*Attribute-levell
IASI” on page 29/

Application-specific information

Application-specific information provides the connector with application-
dependent instructions on how to process business objects. If you extend or modify
a business object definition, you must make sure that the application-specific
information in the definition matches the syntax that the connector expects.

Application-specific information is represented as a name-value pair and can be
specified for the overall business object, for each business object attribute, and for
each verb.

Business object-level ASI

Object-level ASI provides fundamental information about the nature of a business
object and the objects it contains. To view the ASI of a business object, open the
business object in Business Object Designer and click the General tab. The business
object-level ASI displays in the Business Object Level Application-specific
information field. For details about this screen, see [Chapter 5, “Creating and|
modifying business objects,” on page 37|

describes the business object-level ASI of business objects that represent
enterprise beans.

Note: ASI names are not recognized for business objects that represent methods,
method parameters, and method return values. For details about business

object attributes created for methods of enterprise beans, see|"Methods” on|
h

Table 4. Business object-level ASI

Object-level ASI

Description

object_type=RemoteEJB

Indicates that the object is an enterprise bean deployed on an application
server (remote), rather than a standard Java class that is not deployed on
an application server (local).

Jndi_name=<JNDIName>

The JNDI name of the enterprise bean

home_cTlass=<className>

The class name of the home interface

proxy_class=<className

> The class name of the remote interface

The following example illustrates business object-level ASI for a business object
that the connector is processing with enterprise beans deployed on WebSphere
Application Server. When the connector receives the business object from the
broker, it first locates an instance of the home interface
(com.ibm.websphere.AccountBookHome) on the application server, by looking up
WsSamples/Account in the configured JNDI context. The connector than uses this
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home instance to create a new instance of the remote interface
(com.ibm.websphere.AccountBook), which it can use to invoke methods on the E]JB.
BO ASI=object_type = RemoteEJBObject

proxy_class = com.ibm.websphere.AccountBook

home_class = com.ibm.websphere.AccountBookHome
jndi_name = WsSamples/Account

In this code sample:
* BO ASI = object type is required to show that the object is a a remote object.

* proxy_class = com.ibm.websphere.AccountBook represents the name of the
remote stub.

* home_class = com.ibm.websphere.AccountBookHome is the name of the home
interface.

e jndi_name = WsSamples/Account is the JNDI name.
A standard Java object (local) can have a BO ASI = auto_load_or_write.

The business object ASI for a data handler-supported message should contain the
value object_type=dataHandlerObject; mime_type=<text_value> where
<text_value> is the appropriate mime-type defined for the data handler (as
specified in the data handler meta-object) that the adapter should use to convert
the data.

Verb ASI

Every business object contains a verb. A verb indicates which methods to invoke
on the enterprise bean. For the adapter for EJB, the first method should be a
creator method from the corresponding bean’s home interface, and the remaining
methods should be business process methods from the bean’s remote interface.

The verb ASI contains a sequence of attribute names, each of which contains a
method for the business object handler to call. Typically, the method to be invoked
belongs to the object itself (versus belonging to a parent of the business object), in
which case you specify the method in the object’s verb ASL

If the method to be invoked belongs to a parent in the business object hierarchy,
then that parent can be referenced from the child by prefixing the method name
with the PARENT tag.

For example, [Figure 3 on page 29|illustrates a business object hierarchy whereby
ContactDetails is a child object of Contact, which itself is a child of
PSRCustomerAccount.

PSRCustomerAccount
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Figure 3. Business object hierarchy and verb ASI

If a method that belongs to PSRCustomerAccount is called on the ContactDetails
business object, then the verb ASI for ContactDetails represents the business object
hierarchy as follows:

PARENT.PARENT.<methodName>

If the method belongs instead to the Contact business object, then the verb ASI for
ContactDetails must be set as:

PARENT .<methodName>

Note that only methods that belong to parent objects within the hierarchy can be
called. A parent business object cannot invoke a child’s method.

The connector developer determines the EJB operations assigned to the verb.
Supported verbs include:

* Create
* Delete
* Retrieve
* Update

For a given object, you can specify the four supported verbs (Create, Retrieve,
Delete, and Update) and assign as actions of each verb n methods, where n equals
the number of methods in the corresponding enterprise bean.

To view the verb ASI of a business object, open a business object in Business Object
Designer and click the General tab. The verb ASI appears in the Supported verbs
table, which lists the name of the supported verbs and the corresponding ASI for
each verb. For more information about Business Object Designer and the ODA
wizard tabs and screens, see(Chapter 5, “Creating and modifying business objects,”]

Attribute-level ASI

Every business object has a set of attributes, as described in |“Attributes” on page|
that map to corresponding enterprise bean methods and properties. A business
object with a flat structure contains simple attributes, that is, attributes that
represent a single value (such as a string) and do not point to child business
objects. A hierarchical business object contains both simple attributes and child
business objects or arrays of child business objects that contain attribute values.

The ASI of a business object attribute can be for simple attributes and complex
attributes, which contain child objects. For a complex attribute, the ASI varies,
depending on whether the contained child is a property or a method of an object.
The mapping of EJB constructs to the ODA-generated business objects is described
in [Table 8 on page 32|

To view the ASI of a business object attribute, open a business object in Business
Object Designer and click the Attributes tab. Each attribute of the business object is
listed in the Name column. The attribute properties described in [Table 5 on page]
@HTable 6 on page 30} and [Table 7 on page 31} appear in the remaining columns.
Included in these properties is the ASI, which appears in the Application Specific
Information column. For details about this screen, see [Chapter 5, “Creating and)|
modifying business objects,” on page 37
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describes the business object properties of simple attributes. These

properties include the ASI (AppSpecificInfo property) of the attribute. A simple
attribute is always a non-child, for example a boolean, string, or integer value.

Table 5. BO attribute properties: for simple attributes

Attribute property

Description

Name Specifies the business object attribute name.

Type Specifies the business object attribute type. See[Table 8 on page 32 for details about
mapping EJB constructs to business object attribute types.

MaxLength Not used.

IsKey Each business object must have at least one key attribute, which you specify by setting
the key property to true for an attribute. Note that this attribute is used by Business
Object Designer, rather than by the connector.

IsForeignKey Specifies that the connector should check whether or not the object must be stored in

the per call object pool.

IsRequired

Not used.

AppSpecInfo Holds the original Java type. This property is formatted
as follows:
property=<propertyName>, type=<typeName>
property is the name of the EJB attribute or object member variable. Use this
name-value pair to capture the original EJB object member variable name.
type is the Java type of a simple attribute (the EJB object member variable).
For example, type=java.lang.String
See [Table 8 on page 32| for details about mapping EJB constructs to
business object attribute types.

DefaultValue Not used.

describes the elements for complex attributes containing child objects that
are not methods. These elements include the ASI of the attribute.

Table 6. BO attribute properties: for non-method child object attributes

Attribute property

Description

Name

Specifies the business object attribute name.

type

The type of the contained object. Set to proxy if the type is a business object.

ContainedObjectVersion

Not used.

Relationship Specifies that the child is a container attribute. Set to Containment.
IsKey Not used
IsForeignKey Not used
Is Required Not used
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Table 6. BO attribute properties: for non-method child object attributes (continued)

Attribute property

Description

AppSpecificInfo

Holds the original EJB application field name. This property is
formatted as follows:

property=propertyName, use_attribute_value=<(optional)BOName.AttributeName>,
type=<typeName>

property is the name of the EJB object member variable. Use this
name-value pair to capture the original EJB object attribute

name. In the case of an attribute that holds an argument to a
method, do not set a value for property, as the argument does
not have a name and is simply an argument of any standard

type.

use_attribute_value is the business object name formatted

as BOName.AttributeName. Setting this ASI causes the connector
to access the attribute from the per call object pool. Note that
this value is not set in the ODA when you create the business
object, but rather via Business Object Designer.

type is the Java type of a property. See [Table 8 on page 32| for the mapping
of EJB constructs to business objects.)

Cardinality

Set to n if the type represents an array or vector. Otherwise, set to 1.

Table 7. BO attribute properties: for method child object attributes

describes the properties of complex attributes containing child objects that
are methods. These properties include the ASI of the attribute.

Attribute property

Description

Name

The business object attribute name.

type

The business object.

Relationship

Set to Containment, indicating that this is a child object.

IsKey

Set to true if the attribute name equals UniqueName, otherwise it is set to false.

IsForeignKey

Set to false.

Is Required

Set to false.

AppSpecificInfo

Holds the exposed remote method interface name, which is the
name of the method call placed to the EJB server by the enterprise bean.
This attribute is formatted as:

method_name=<remoteClassName.RemoteMethodName>

If the method is a constructor, method _name=CONSTRUCTOR

Cardinality

Set to 1.

Note that methods have arguments and return values. Arguments and return
values can be complex (containing child objects) or simple.
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Mapping attributes: Enterprise JavaBeans (EJB) and business object

This section provides a list of the EJB constructs defined in a JAR file and their
corresponding business object attributes. For all business object attributes that are
not child business objects, the data type is String. In a business object, the ASI
holds the actual data type of the attribute and is used when invoking methods
against the enterprise bean’s remote interface.

For details about business object ASI, see [“Application-specific information” on|

Table 8. Object mapping: Enterprise bean to business object

EJB construct Business object Attribute ASI type=
All classes whose reference is Object proxy_class=<remote
found in the JAR file interface name>
boolean Boolean type=boolean/Boolean
char/Character String type=char/Character
byte/Byte String type=byte/Byte
java.lang.String String type=string
short/Short Integer type=short/Short
int/Integer Integer type=int/Integer
long/Long Integer type=Tlong/Long
float/Float Float type=float/Float
double/Double Double type=double/Double
java.math.BigDecimal String type=java.math.BigDecimal
java.math.BigInteger String type=java.math.BigInteger
class Object proxy_class=<fully qualified
class name>
array Object type=Array0f_<datatype>
Child business object | For example, type=Array0f_int
with multiple
cardinality
method Object method_name=<methodName>
Child BO
method (no argument and void String method_name=<methodName>
return type)

Note: In cases where the attribute is not intended to be de-referenced, the ASI
type=PlaceholderOnly should be used. This tells the connector to not
populate this attribute. The attribute may still be used as part of a multi-call
flow if it is either marked as a foreign key (IsForeignKey is set to true), or
has the ASI use_attribute_value pointing to a compatible attribute.

Array types
Note the following about array types:

* To use an array type, specify an ASI of type=ArrayOf_<value>, where value is
one of the attribute ASI values listed in For example, type=Array0f_int
specifies an array of int variables. These are mapped to a cardinality n business
object that contains the element.
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* An Object array (Object[]) in Java has a corresponding ASI type of
ArrayOf_proxy. The processing of proxy objects is done against every element of
the array. If the proxy array is an argument to a function, verb processing will
occur on every object in the array before executing the method. If the array is a
return value, verb processing will occur on every object in the array after
executing the method.

* A sized array may be used as input but not as output.

¢ A SafeArray is supported as both an input and a return value.

Running the adapter to invoke sample business objects

The following topics describe running the sample files delivered with the product
and provide examples that illustrate how the connector invokes the services of a
JAR file to create business objects.

¢ ['Running the sample files”|
* |“EJB JAR file code” on page 34|
+ |“Business object sample” on page 35|

Running the sample files

The sample files are located in the ProductDir\connectors\EJB\samples directory,
where ProductDir represents the directory where the connector is installed.

It is a requirement that the WebSphere Application Server Thin Client must be
installed for the adapter to remotely access the beans deployed on the server.

Note: The Application Server Thin client cannot be installed to a directory that has
spaces in its name.

The sample files illustrate a simple session bean, MusicCart, that provides a home
interface, remote interface, bean and two helper classes, RecordingHelper and
CustomerHelper. The sample files also include two connector configuration files:
BIA_EJBConnector.cfg, which contains the connector properties settings for the
example to run properly; and BIA_PortConnector.cfg, which contains the
connector properties for the test connector.

The MusicCart sample bean has methods that take a Java object as an input
parameter and return an object as output. It also has methods that take an object
array as an input, illustrating how the adapter handles array management. The
sample also demonstrates how the adapter performs data handler processing.

Included in the sample files is a business object file (BIA_SampleMusicCartB0.bo)
and EJB source files (in
ProductDir\connectors\EJB\samples\SampleMusicCartEJB\src), which show how
EJB remote and home classes are mapped to business objects using the ODA for
EJB. By sending BIA_SampleMusicCartB0.bo from the test connector to the
application server, you can see how the addRecording, getFirstRecordInfo,
modifyMusicRequestUsingDataHandler, and getAlTRecordInfo methods are executed
and how the connector handles request processing.

The following steps assume that you are running the connector to exchange
business objects with enterprise beans deployed on WebSphere Application Server
5.0.

1. Install the adapter for EJB as described in [Chapter 2, “Installing the adapter,”]|
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2. Deploy the EJB JAR file ProductDir\connectors\EJB\samples\
SampleMusicCartEJB\BIA_MusicBeanSample.jar to your instance of WebSphere
Application Server 5.0.

3. Load the two connector configuration files in the
ProductDir\connectors\EJB\samples\ directory (BIA_EJBConnector.cfg and
BIA_PortConnector.cfg) into the repository of your integration broker, for
example InterChange Server.

4. Load the sample business objects from the
ProductDir\connectors\EJB\samples\Samp1eBOs directory into the broker
repository.

5. Modify the connector startup file to point to the location of the JAR file
(BIA MusicBeanSample.jar) you deployed in Step El For information about
editing the startup file, see [“Configuring the startup file” on page 21/

6. In the startup file, uncomment the commands for your application server
settings. For this sample, you must uncomment the commands for WebSphere
Application Server, since this sample assumes you are running the connector to
exchange business objects with enterprise beans deployed on WebSphere
Application Server 5.0.

7. Start the WebSphere Application Server instance.

8. %rt running the connector, as described in [“Starting the connector” on page]

9. Send the file BIA SampleMusicCartB0.bo from the test connector to the
application server.

As the connector runs, you can observe how the enterprise bean methods defined
in the sample files are executed from the adapter to invoke services provided by
the remote WebSphere Application Server.

EJB JAR file code

The following sample code is an excerpt from the EJB JAR file that defines the
methods of the EJB class called MusicCartBean. Notice the method defined at the
end of the code sample: getCustomer.

Note: Not all of the methods for this class are defined in the code sample
provided here. The sample is a section of a larger file described in
[the sample files” on page 33|

The business object that corresponds to this code is illustrated in [Figure 4 on page]

public class MusicCartBean implements SessionBean {
CustomerHelper customerHelper;
ArraylList shoppinglList;
RecordingHelper[] recordHelperArr;

// EJB Methods

public void ejbRemove() {}

public void ejbActivate() {}

public void ejbPassivate() {}

public void setSessionContext (SessionContext ctx) {}

public void ejbCreate(String person,String password, String email)
throws CreateException {
if (person == null || person.equals("")) {
throw new CreateException(
"Name cannot be null or empty.");
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1

else {
customerHelper = new

CustomerHelper(person, password, email);

customerHelper.setName(person);
customerHelper.setEmail(email);
customerHelper.setPassword(password);

1

shoppinglList = new ArraylList();

public void ejbCreate(CustomerHelper customerHelper)
throws CreateException {
customerHelper.setName (customerHelper.name);
customerHelper.setEmail (customerHelper.email);
customerHelper.setPassword(customerHelper.password);
shoppinglList = new ArraylList();
}

// Business methods implementation

public CustomerHelper getCustomer() {
return customerHelper;
}

Business object sample

The following sample screen illustrates the business object structure that
corresponds to the source code presented in [“EJB JAR file code” on page 34| This
business object is created by the ODA, which discovers the objects and constructs
defined in the original EJB JAR file and generates corresponding business objects.
For information about how to use the ODA to generate this example, see
(Chapter 5, “Creating and modifying business objects,” on page 37.|

Notice the fourth attribute, getCustomer. This attribute contains a complex method
object that corresponds to the getCustomer method defined at the end of the
sample code for the MusicCartBean class, presented in [‘E]B JAR file code” on page]
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Figure 4. Business object level ASI and supported verbs
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Generating business objects

Each time an event occurs during run time, an EJB application sends a message
object containing object-level data and information about the type of transaction.
The connector maps this data to the corresponding business object definition, to
create an application-specific business object. The connector sends these business
objects on to the integration broker for processing. It also receives business objects
back from the integration broker, which it passes back to the EJB application.

Note: If the object model in the EJB application is changed, use the ODA to create
a new definition. If the business object definitions in the integration broker
repository do not match exactly the data that the EJB application sends, the
connector is unable to create a business object and the transaction will fail.

Business Object Designer provides a graphical interface that enables you to create
and modify business object definitions for use at run time. For details, see
(Chapter 5, “Creating and modifying business objects,” on page 37.|
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Chapter 5. Creating and modifying business objects

This chapter describes how to create business objects using the ODA (Object
Discovery Agent) for EJB, and contains the following sections:

+ [“Overview of the ODA for EJB’]
* |“Generating business object definitions”|

» [“Uploading business object files” on page 50|

+ [“Collection object processing” on page 43

Overview of the ODA for EJB

An ODA enables you to generate business object definitions. A business object
definition is a template for a business object. The ODA examines specified
application objects, “discovers” the elements of those objects that correspond to
business object attributes, and generates business object definitions to represent the
information. Business Object Designer provides a graphical interface to access the
Object Discovery Agent and to work with it interactively.

The ODA for EJB generates business object definitions from metadata contained in
EJB JAR files. The Business Object Designer wizard automates the process of
creating these definitions. You use the ODA to create business objects and
Connector Configurator to configure the connector to support them. For
information about Connector Configurator, see [Appendix B, “Connector]
(Configurator,” on page 79.|

Generating business object definitions

This section describes how to use the EJB ODA in Business Object Designer to
generate business object definitions. For information on launching and using
Business Object Designer, see IBM WebSphere Business Integration Adapters Business
Object Development Guide.

Starting the ODA

The ODA can be run from any machine that can mount the file system on which
the metadata repository (the JAR files) resides, using the ODA startup file. This file
contains start parameters, including the paths to certain required EJB and
connector JAR files. These JAR files must also be accessible from the machine on
which you are running the ODA.

The ODA for E]B has a default name of EJBODA. The name can be changed by
changing the value of the AGENTNAME variable in the start script.

To start the ODA, run this command:
* start EJBODA.bat (Windows 2000)
e start_EJBODA.sh (Unix)

The CLIENT JARPATH variable of the startup file contains no default value, so before
running the start command, set the value to the directory and filename of the
client JAR path, so as to allow the ODA to include the file in its Java class path.
For example:
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set CLIENTJARPATH=C:\BIA MusicBeanSample.jar

Running Business Object Designer

Business Object Designer provides a wizard that guides you through the steps to
generate a business object definition using the ODA. The steps are as follows:

Select the agent
To select the agent, follow these steps.
1. Start Business Object Designer.

2. Click File > New Using ODA. The Business Object Wizard - Step 1 of 6 - Select
Agent screen appears.

3. Select the ODA/AGENTNAME in the Located agents list and click Next. (You
may have to click Find Agents if the desired agent is not listed.)

Business Ohject Wizard - Step 1 of 6 - Select Agent P ] |
Prezs "Find Agents" to locate DDAz Located agents:
in pour zubnet (3026, 234 @], Yo
will be given an estimate of the time EJBODA [local host:57037]

required to complete the operation
and a means to cancel the search.

If wou have an ODA that iz running
on a maching outside subnet

9.26. 234 wew prezs 'Configure
Digcovery' to include that machine
in the zearch.

Configure Dizcoverny |

Eind Agents |

Agent's name: Tao be discoverad

Agent's hogt; I

Fort; I—

< Back | Hent = Cancel

Figure 5. Select Agent screen

Configure the agent

After you click Next on the Select Agent screen, the Business Object Wizard - Step 2
of 6 - Configure Agent screen appears. [Figure 6 on page 39| illustrates this screen
with sample values.
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Business Object Wizard - Step 2 of 6 - Configure Agent =] =]
 Profiles
Current profile: | j
Save | A=Y | Femove |
Property Value Type Descrip
1 BOPrefix String Prefix that will bhe u
2 |EJBJarFilePath ChBlA_MusicBeanSample jar String The directory wher
3 | TraceFileMame Bla_EJBODAtrace txd String Mame of the trace f
4 | TracelLevel 5 Integer Trace level for the
5 |MeszageFie Bla_EJBODAAgent fxt String Mame of the errar 5
L | i
< Back | Mext > | Cancel |

Figure 6. Configure Agent screen

The properties you set on this screen are described in You can save all the
values you enter on this screen to a profile. Instead of retyping the property data
the next time you run the ODA, you simply select a profile from the Current
profile drop-down menu and re-use the saved values. You can save multiple
profiles, each with a different set of specified values.

Table 9. Configure Agent properties

Property name

Default value

Type

Description

EJBJarFilePath

None

String

(required) The fully qualified path to the EJB JAR
file. This is the file that the ODA reads as input to
generate business objects.

DefaultBOPrefix

None

String

The prefix that the ODA will add to the names of the
business objects it generates

TraceFileName

<agentname>trace.txt

String

The name of the trace message file; for example,
BIA_EJBODAtrace.txt. Note that the connector
supports globalized values for this property, which
means that the file path and name can be globalized,
though the file content cannot.

Tracelevel

Integer

(required) The tracing level (from O to 5) for the

Agent. For details about tracing levels, see
—

MessageFile

<agentname>Agent.txt

String

The name of the message file that contains all the
messages displayed by the ODA. For the connector
for EJB, the name of this file is BIA_EJBODAAgent.txt.
If you do not correctly specify the name of the
message file, the ODA will run without messages.
Note that the connector supports globalized values
for this property, which means that the file path and
name can be globalized, though the file content
cannot.
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1. Type the value of the property in the Value column of the Configure Agent
screen, illustrated in [Figure 6 on page 39|

2. Use the New and Save buttons in the Profiles group box to create a new
profile. When you use the ODA again, you can select an existing profile.

Note: If you use an existing profile, the property values are filled in for you,
though you can modify the values as needed.

Select an EJB object

The Business Object Wizard - Step 3 of 6 - Select Source screen appears, as illustrated
in The screen lists the objects that have been defined in the EJB JAR file.
Use this screen to select any number of EJB objects for which the ODA will
generate business object definitions.

Notice that the list contains a total of eight methods. The first two objects in the
list are the creator methods from the home interface. The remaining six methods
are remote interface business methods.

Business Object Wizard - Step 3 of 6 - Select Source |

From the tree below, select the source nodes from which the DDA will generate business object definitions. Click "Next" to continue.
Uze thiz object instead

MName Description
- com.ibm_samples.ejbS ample_MusicCartHome EJB Component in the tree library.
- create[com.ibm_samples. ejbS ample. CustomerHelper] Methods in the selected EJB Component.
- createfjava.lang.String, java.lang String, java.lang. String) Methods in the selected EJB Component.
=1+ com.ibm.samples. ejbS ample. MusicCart EJB Component in the tree library.
- getAllRecordinfol) Methods in the selected EJB Component.
- modifyMusicR equestUsingD ataH andler(java.lang.5tring) Methods in the selected EJB Component.
- getFirstRecordinfol) Methods in the selected EJB Component.
- getCustomer() Methods in the selected EJB Component.
- removeRecording({com_ibm. samples. ejbS ample. RecordingHelp... | Methods in the selected EJB Component.
- addRecording[com_ibm_samples_ejb5 ample_ RecordingHelper) Methods in the selected EJB Component.
< Back Wewt » Cancel

Figure 7. Select Source screen

1. If necessary, expand an E]JB object to see a list of methods of the object.

2. Select the E]JB object(s) you want to use. For example, you can select the
following:

* An EJB object and a few of its methods.
* A few methods of an EJB object but not the object itself.
¢ The methods of different EJB objects.

* Only a home interface object. When only a home interface object is selected,
the ODA will generate business objects for all home interface methods.

* Only a remote interface class object. When only a remote interface object is
selected, the ODA will generate business objects for all remote interface
methods.
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In [Figure 7 on page 40, the MusicCartHome and MusicCart class are selected.
Although only the class names are selected, the ODA will also create objects of
the associated methods of each selected class.

3. Click Next.

Confirm the object selection
The Business Object Wizard - Step 4 of 6 - Confirm source nodes for business object
definitions screen appears. It shows the object(s) you selected.

Business Object Wizard - Step 4 of & - Confirm source nodes for business o... [l[=] E3

Buziness objects definitions are about to be generated for the source nodes summarized
below. Click "Mexst" to start generating the business object definitions or click "Back" to
change your selection.

MHame Diezcription

+ com.lbm. samples.ejbSample. MusicCart... | EJB Component in the tree ...
= com.ibm.samples_ejbSample MusicCart EJB Component in the tree __

< Back Mext » Cancel

Figure 8. Confirm source node screen

Click Back to make changes or Next to confirm that the list is correct.

The Business Object Wizard - Step 5 of 6 - Generating business objects... screen appears
with a message stating that the wizard is generating the business objects.

Select verbs and assign the JNDI name

After you click Next, the Enter [NDI name for this Enterprise Java Bean screen
appears. It appears for each selected EJB source object. Use this screen to select the
supported verbs for this object and to assign a JNDI name.

In the example provided in [Figure 9 on page 42} the JNDI name assigned is
MusicCartJNDI.
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: BO Properties - Enter JNDI Mame for this Enterprise Java Bean.MusicCart

Property Value Type Description
1 “erbs - | String Select supported verbs.
2 JMDINameF orMusicCart| MusicCartJMDI String Erter JMCI Mame for this Enterprize Java Bean.
i | 2

Figure 9. Enter JNDI Name for Enterprise Java Bean screen

On this screen you also specify the verbs that the business object supports. The
ODA allows you to specify the four supported verbs (Create, Retrieve, Delete, and
Update) and assign as actions of each verb n methods, where n equals the number
of methods in the corresponding EJB object. To specify additional verbs beyond the
supported four, or to edit verb information after you create a business object, use
Business Object Designer.

For details about business object verbs for the EJB connector, see[“Verb ASI” o

1. In the Value list for the Verbs property, select the verbs that you want the

business object to support. You can select one or more verbs. You can also
deselect a verb at any time.

2. In the JNDI name for <className> property, enter the JNDI name of the
enterprise bean. This name is defined at the time when the bean is deployed
onto the application server.

3. Click OK.
Specify the verb ASI

For each verb you select, a separate window appears where you specify the
method sequence that must be executed for the verb.

[Figure 10 on page 43| illustrates this screen for the Create verb of the MusicCart
business object created in [Figure 7 on page 40| and |[Figure 8 on page 41}
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+ BO Properties - ¥erb = Create & Component = com.ibm.samples.ejbSample.MusicCart

Property Value Type Description
1 MethodSequence create j String Select the method sequence for the component show
2 MethodSequence addRecording String Zelect the method sequence for the component show
) MethodSequence getFirstRecordinfo String Select the method sequence for the component show
4 MethodSequence modifyrusicRequestUsingDataHandler String Select the method sequence for the component show
= MethodSequence String Select the method sequence for the component show
5} MethodSequence String Select the method sequence for the component show
7 MethodSequence String Select the method sequence for the component show
a8 MethodSequence String Select the method sequence for the component show

4

Figure 10. Setting the verb method sequence

1.

In the Value list for the MethodSequence property, click the method that you

want the business object to execute first for the verb. In the method
sequence is as follows:

The first method required in the method sequence of any EJB business object
verb is a creator or finder method, defined in the home interface of the
enterprise bean. In the first method is create, which the connector
uses to obtain a reference to the remote interface and create an instance of
the enterprise bean.

Note that if the first method selected on the verb ASI is not a creator or
finder method, the connector will display the following error message:The
first method obtained from the 1list of methods in the ver ASI is not a
home creator method. Select a creator method from the home interface
and try again.

The second method in the sequence is addRecording. This method belongs to
the enterprise bean’s remote interface.

The third method in the sequence is getFirstRecordInfo. This method
belongs to the enterprise bean’s remote interface.

The last method in the sequence is modifyMusicRequestUsingDataHandler.
This method belongs to the enterprise bean’s remote interface.

By specifying a method sequence for the verb, you are creating the verb ASI
that is associated with that verb. If necessary, this verb ASI can be modified
later using Business Object Designer.

2. Click OK.

Collection object processing

The ODA will generate business objects for collection objects found in the input
parameter or return parameter lists. The following collection classes are supported:

 List Classes: ArrayList, LinkList, Vector, Stack, HashSet
* Map Classes: HashMap, TreeMap, WeakHashMap, HashTable, Attributes
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Verify class and method

For each collection object passed as an argument/return type, the ODA will
display a message similar to the one shown in The message will state
the collection object that is currently processing.

x

Processing collection object parameter for
Method Name: addRecording

From class: com.ibm.samples, ejbSample.MusicCart

QK

Figure 11. Verify class and method
Press OK if the collection object information is correct.

Select number of object types
Use the Parameter Object Type Info screen to enter the number of different object
types you intend to store in your collection object.

- B0 Properties - Paramber Dhpect Type Inlo for Methed addRecording ;i x|

[ Froperty ]_ Value | Type 1 _ Descrigtion

Figure 12. Select number of object types

Press OK when you are done.

The ODA will display the following warning:
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Agent EJBODA Notification

Mow we are selecting the classes stored in the collection object.

Figure 13. Verify settings

select any AppServer generated classes,

o |

when choosing class names from the list, please do nat

Confirm that you did not select any AppServer generated classes when you
selected your class name before selecting OK.

Create map objects
When the ODA discovers a Map Class, where a map is an object that maps keys to
values, users will be asked to select an object type for the key and an object type

for the values as shown in Each name/value pair in the map object

maps to two business objects-- one for the key and one for the value object.

Note: A map cannot contain duplicate keys and each key can only map to, at

most, one value.

 BO Properties - Parameter Info for Method addRecording

Property

Value

Type

Description

KeyClassType_1

YalueClassType_1

A

String

Map Object Key Type

1

Character -

String

Map Ohject Yalue Type

Date

Double

Float

Integer

Long

Short

String
com.ibm.samples ejbSample CustomerHelper
com.ibm.samples.ejbSample MusicCart
com.ibm.samples ejpSample RecordHelper __|
com.ibm samples ejbSample RecordingHelper ¥

Figure 14. Create map objects

Create list objects
When the ODA discovers a Vector or other list object, you must select the type of
objects you want to store in the collection object from the drop down menu.
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1 BO Properties - Parameter Info for Method add

Picture
wn O @ 5t ol

Property

Value

I Type

1 OhjectClassType

com.ibm samples ejbSample CustomerHelper

Character

Date

Double

Flost

Integer

Long

Short

String

com.ibm samples ejbSample CustomerHelper
com.ibm.samples ejbSample MusicCart
com.ibm.samples ejbSample RecordHelper

ﬂ String
-~

Objec

com.ibm.samples ejbSample Rec

ordingHelper

2l

Figure 15. Select object types

Mapping multiple getter/setter methods to a single java object

If an Enterprise JavaBean takes a java object as an argument or a r
the java object has many getter/setter method types, the screen in
appear. Use this screen to select which getter/setter methods should be mapped to

the attribute of your business object.

If you do not select getter/setter from this screen, then getter/setter methods will

be mapped to business objects instead of to business object attributes.

eturn type, and

Figure 16| will

+ BO Properties - Select getter or setter methods of com.ibm.samples.ejbSample.RecordHelper - x|
|
Property Value Type Description
1 GetterSetters |gethiusicURLO) String | Select gefter or sefter methods that are mapped to member varables
GetterSetters |gethiusicThie() String | Select getter or sefter methods that are mapped to member variables
GetterSetters | settusicURL(ava ang String) String | Select getter or setter methods that are mapped to member variables
GetterSetters | sethusicThle(ava lang String) String | Select getter or setter methods that are mapped to member varisbles
GetterSetters sethiusicSinger(java lang String) String Select getter or sefter methods that are mapped to member variables:
GetterSetters |gethtusicSinger() String |Select getter or sefter methods that are mapped to member variables
7 GetterSetters | String |Select gefter or sefter methods that are mapped to member variables
5 GetterSetters [String [Select gefter or sefter methocis that are mapped to member variables
‘ | |
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Figure 16. Mapping multiple getter/setter methods to the attribute of a business object

Opening or saving the business object

The Business Object Wizard - Step 6 of 6 - Save business objects screen appears.

Business Object Wizard - Step 6 of 6 - Save business object definitions 0] x|

Business abject definitions were successfully created. You can save themto a
project, & file ar both,

[" Save a copy of the business object definitions to a separate file

W Open the new business object definitions in separate windows

™ Shutdown ODA Bl&_EJBODA,

< Back Finizh Cancel

Figure 17. Save business objects screen

You can optionally open the new business objects in separate windows within
Business Object Designer, or (after specifying a key for the top-level business
object) you can save the generated business object definitions to a file.

To open the business objects in separate windows

1. Select Open the new BOs in separate windows.

2. Click Finish. Each business object appears in a separate window where you can
view and set the ASI information for the business objects and business object

verbs you just created. For details, see [“Select verbs and assign the JNDI name”|
[on page 41]and [“Specify the verb ASI” on page 42]

To save the business objects to a file (only after you specify a key for the
parent-level business object):

1. Select Save a copy of the business objects to a separate file. A dialog box
appears.

2. Type the location in which you want the copy of the new business object
definitions to be saved.

Business Object Designer saves the files to the specified location.

If you have finished working with the ODA, you can shut it down by checking
“Shutdown ODA EJBODA” before clicking Finish.
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Specifying the attribute-level ASI

After you define the verb ASI (by specifying a method sequence that must be
executed for each verb), Business Object Designer displays the attributes for the
business object. For details about the attribute-level ASI in the EJB connector, see
[“Attribute-level ASI” on page 29|

The attributes are listed on the Attributes tab in the order in which they appear in
the EJB object structure, as defined by the numeric value in the Pos column.
Simple EJB object attributes are represented as simple attributes and their ASI
contains the original EJB attribute name and type.

For each attribute, the screen provides the name of the attribute, its type, and the
ASI information. [Figure 18 on page 49| illustrates the method (complex) attributes.
The getATTRecordsInfo attribute of the business object has an ASI that maps the
attribute to the original EJB object method. In this example, the original method is
indicated under the App Spec Info column, by the method_name=getAl1RecordInfo
ASIL.

The getCustomer attribute of the business object has an ASI that maps the attribute
to the original EJB object method. In this example, the original method is indicated
under the App Spec Info column, by the method_name=getCustomer ASI.

In addition, getCustomer (a child business object) has the child object attribute
Return_Value, which is used to capture the return value of the getCustomer
method. In the EJB JAR file, the method is defined as having a return value of type
CustomerHelper, which itself is a method. The attribute ASI of CustomerHelper is
set to type=proxy because the object type is a return value. Note that if a method
in the EJB JAR file does not return a value, the Return_Value attribute is not
included in the list of business object attributes.

Notice also that the Return_Value attribute of type CustomerHelper has three
non-method child object attributes: name, password, and email. In the original EJB
JAR file where the MusicCartBean class is defined, these are all defined as
parameters of type String of the CustomerHelper method. In the business object,
the attribute ASI of these parameters indicates the Java property name and type
(String) of each in the original JAR file.
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Figure 18.

Setting the attribute ASI

[E Business Object Designer - [MusicCart-Local Project *] - =10 x|
@ Fie Edt Yiew Tocks ‘Window Help =% x|
=N~ Y B ++\68 B85
| strintes |
Iame | Tyme ‘Kev |F°"W" |“=W' |f-ﬂfﬂ"‘n ]Manmm Length Appication Specific information

1 & sddRecordng MusicCart_adaRecordng r r r 1 method_name=addRecording

2 B adcRecordng_1 Cart_sdoRecording_ C [} m] 1 Irtho_neme=sddReconding

& & adcfecords Cart_atoRecords r i o] 1 method_nsme=sddRecords

O B crenie CortHome_crente: ] IS r 1 methon_namescreate

5 B getAIReCOrdn1ommations: MUZICCEr_getAIRECOrdntormetions rC [ r 1 method_name=getAIRecordnomations:

g B gt AlRecordintos MusicCart_getAlRiecordnios m =] r 1 method_nome=petAlRecordinios

7 B getAlRecords MuzicCart_getAlRecords O (] C | method_neme=petAlRecords

g | cviectEvent String

& O] O r 55

| | ]

Resdy

Figure 19. Setting the attribute ASI

On this screen, you should specify whether or not a parent-level object is a key
(which is required by the ODA for saving the business objects to a separate file).
You can also use this screen to set child object keys as needed and to specify the
following information:

* Is the attribute required for the connector to process the business object? If so,
click the Required check box.

* Is the maximum length of the attribute different from the value that appears in
the Maximum Length column?

* Does the attribute have a default value? If so, type the value in the Default
column.

Note: While you can create a business object through the ODA (running in
Business Object Designer) and set the parent level key(s), do not configure
the foreign key in this manner. The foreign key is non-ASI metadata and
therefore must always be configured without the ODA (in Business Object

Designer, click File > New to create a new business object without using the
ODA).

Specifying the business object-level ASI

You can view and modify the business object-level ASI. For details about business
object-level ASI, see [“Business object-level ASI” on page 27

The business object-level ASI is listed on the General tab. The ASI value that
appears in the field Business Object Level Application-specific information
contains the name of the remote interface that corresponds to this business object.
The connector uses this information to map a remote object to a business object.
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The General tab also lists all the verbs that are supported by the business object
and provides the ASI for each verb, as it was defined in [‘Specify the verb ASI” on|
If a verb is blank, then a method sequence will not be executed for that
verb.

Uploading business object files

The newly created business object definition files must be uploaded to the
integration broker once they have been created. The process depends on whether
you are running WebSphere InterChange Server, WebSphere MQ Integrator Broker,
or WebSphere Application Server.

* WebSphere InterChange Server: If you have saved your business object
definition files to a local machine and must upload them to the repository on the
server, refer to the InterChange Server implementation documentation.

* WebSphere MQ Integrator Broker: You must export the business object
definitions out of Business Object Designer and into the integration broker. For
details, refer to the implementation documentation of WebSphere MQ Integrator
Broker.

* WebSphere Application Server: For details, see the implementation
documentation of WebSphere Application Server.
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Chapter 6. Troubleshooting and error handling

This chapter describes how the connector for EJB handles errors. The connector
generates logging and tracing messages. This chapter describes these messages and
provides troubleshooting tips. The chapter contains the following sections:

* [“Error handling”]|

* |"Logging” on page 52|
* [“Tracing” on page 52

Error handling

All messages generated by the connector are stored in a message file named
BIA_EJBConnector.txt. (The name of the file is determined by the LogFileName
standard connector configuration property.) Each message has a message number
followed by the message:

Message number
Message text

The connector handles specific errors as described in the following sections.

ClassNotFound for proxy

An exception is raised when the connector cannot find a given remote interface in
the EJB JAR file provided by the user for exchanging data with the connector. The
connector logs the error, which includes the name of the class not found, and
returns a FAIL code.

InstantiationException in Loader

When the connector receives the enterprise bean class name and tries to create an
object of that class, an exception is raised if it cannot create the object instance. The
connector logs the error, which includes the class name of the object that cannot be
instantiated, and returns a FAIL code.

lllegal AccessException in Loader or Invoker

The connector raises an exception due to invalid code or improper access (public
or private) on a method.

The connector logs the error and returns a FAIL code.

NoSuchMethodException in Invoker

The connector raises an exception if a method is specified on the business object
that does not exist in the corresponding enterprise bean object. Since methods are
loaded dynamically, this exception is raised when the method is not found in the
class.

The connector logs the error and returns a FAIL code.

InvocationTargetException in Invoker

The connector raises an exception when the EJB application (with which the
connector is exchanging business objects) raises an exception.
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The connector logs the error and returns a FAIL code.

Invalid argument (CXilgnore) in a method object in Invoker

The connector raises an exception when a method is included in the business
object’s verb ASI, but the arguments of that method have not been populated.

The connector logs the error and returns a FAIL code.

Cast failure or wrong attribute type

The connector raises an exception if an EJB object method takes or returns a
different data type than what has been specified in the business object.

The connector logs the error and returns a FAIL code.

Invalid verb ASI

The connector raises an exception if the verb ASI of the business object being
passed to it is formatted incorrectly or uses improper syntax. Examples of this
include a verb ASI that does not contain a proper method sequence.

The connector logs the error and returns a FAIL code.

App response timeout

The connector raises an exception if it loses the connection to the Application
Server where the enterprise beans are deployed or if it cannot invoke an EJB
method due to a connection failure.

The connector logs the error and returns a FAIL code.

Logging

All errors described in [“Error handling” on page 51| must be read from the
message file (BIA_EJBConnector.txt).

Tracing

Tracing is an optional debugging feature you can turn on to closely follow
connector behavior. Trace messages, by default, are written to STDOUT. For more on
configuring trace messages, see the connector configuration properties in
[“Configuring the connector” on page 13.|For more information on tracing,
including how to enable and set it, see the Connector Development Guide.

able 10 lists the recommended content for connector tracing message levels.

Table 10. Tracing messages content

Level Description

Level 0 Use this level for trace messages that identify the connector version. No
other tracing is performed at this level.

Level 1 Use this level for trace messages that:
* Provide status information.
* Provide key information on each business object processed.

* Record each time a polling thread detects a new message in an input
queue.
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Table 10. Tracing messages content (continued)

Level Description

Level 2 Use this level for trace messages that:
* Identify the BO handler used for each object that the connector processes.
* Log each time a business object is posted to the integration broker.

* Indicate each time a request business object is received.

Level 3 Use this level for trace messages that:

* Identify the foreign keys being processed, if applicable. These messages
appear when the connector has encountered a foreign key in a business
object or when the connector sets a foreign key in a business object.

* Relate to business object processing. Examples of this include finding a
match between business objects, or finding a business object in an array
of child business objects.

Level 4 Use this level for trace messages that:

* Identify application-specific information. Examples of this include the
values returned by the methods that process the application-specific
information fields in business objects.

* Identify when the connector enters or exits a function. These messages
help trace the process flow of the connector.

* Record any thread-specific processing. For example, if the connector
spawns multiple threads, a message logs the creation of each new thread.

Level 5 Use this level for trace messages that:

* Indicate connector initialization. This type of message can include, for
example, the value of each connector configurator property that has been
retrieved from the broker.

* Detail the status of each thread that the connector spawns while it is
running.

* Represent statements executed in the application. The connector log file
contains all statements executed in the target application and the value of
any variables that are substituted, where applicable.

* Record business object dumps. The connector should output a text
representation of a business object before it begins processing (showing
the object that the connector receives from the collaboration) as well as
after it finishes processing the object (showing the object that the
connector returns to the collaboration).
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Appendix A. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of WebSphere Business Integration adapters. The information covers
connectors running with the following integration brokers:

* WebSphere InterChange Server (ICS)

* WebSphere MQ Integrator, WebSphere MQ Integrator Broker, and WebSphere
Business Integration Message Broker, collectively referred to as the WebSphere
Message Brokers (and shown as WMQI in the Connector Configurator).

* Information Integrator (II)
* WebSphere Application Server (WAS)

If your adapter supports DB2 Information Integrator, use the WMQI options and
the DB2 II standard properties (see the Notes column in [Table 11 on page 57|.)

The properties you set for the adapter depend on which integration broker you
use. You choose the integration broker using Connector Configurator. After you
choose the broker, Connector Configurator lists the standard properties you must
configure for the adapter.

For information about properties specific to this connector, see the relevant section
in this guide.

New properties

This standard property was added in this release:
* BOTrace

Standard connector properties overview

Connectors have two types of configuration properties:
 Standard configuration properties, which are used by the framework

* Application, or connector-specific, configuration properties, which are used by
the agent

These properties determine the adapter framework and the agent run-time
behavior.

This section describes how to start Connector Configurator and describes
characteristics common to all properties. For information on configuration
properties specific to a connector, see its adapter user guide.

Starting Connector Configurator

You configure connector properties from Connector Configurator, which you access
from System Manager. For more information on using Connector Configurator,
refer to the sections on Connector Configurator in this guide.

Connector Configurator and System Manager run only on the Windows system. If

you are running the connector on a UNIX system, you must have a Windows
machine with these tools installed.
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To set connector properties for a connector that runs on UNIX, you must start up
System Manager on the Windows machine, connect to the UNIX integration broker,
and bring up Connector Configurator for the connector.

Configuration property values overview
The connector uses the following order to determine a property’s value:

1. Default
2. Repository (valid only if WebSphere InterChange Server (ICS) is the integration
broker)

3. Local configuration file

4. Command line

The default length of a property field is 255 characters. There is no limit on the
length of a STRING property type. The length of an INTEGER type is determined
by the server on which the adapter is running.

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s update
method determines how the change takes effect.

The update characteristics of a property, that is, how and when a change to the
connector properties takes effect, depend on the nature of the property.

There are four update methods for standard connector properties:

* Dynamic
The new value takes effect immediately after the change is saved in System
Manager. However, if the connector is in stand-alone mode (independently of
System Manager), for example, if it is running with one of the WebSphere
message brokers, you can change properties only through the configuration file.
In this case, a dynamic update is not possible.

* Agent restart (ICS only)
The new value takes effect only after you stop and restart the connector agent.

* Component restart
The new value takes effect only after the connector is stopped and then restarted
in System Manager. You do not need to stop and restart the agent or the server
process.

e System restart
The new value takes effect only after you stop and restart the connector agent
and the server.

To determine how a specific property is updated, refer to the Update Method
column in the Connector Configurator window, or see the Update Method column
in [Table 11 on page 57

There are three locations in which a standard property can reside. Some properties
can reside in more than one location.

* ReposController
The property resides in the connector controller and is effective only there. If
you change the value on the agent side, it does not affect the controller.

* ReposAgent
The property resides in the agent and is effective only there. A local
configuration can override this value, depending on the property.
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* LocalConfig

The property resides in the configuration file for the connector and can act only

through the configuration file. The controller cannot change the value of the
property, and is not aware of changes made to the configuration file unless the
system is redeployed to update the controller explicitly.

Standard properties quick-reference

able 11| provides a quick-reference to the standard connector configuration
properties. Not all connectors require all of these properties, and property setting
may differ from integration broker to integration broker.

See the section following the table for a description of each property.

Note: In the Notes column in the phrase “RepositoryDirectory is set to
<REMOTE>" indicates that the broker is InterChange Server. When the
broker is WMQI or WAS, the repository directory is set to
<ProductDir>\repository

Table 11. Summary of standard configuration properties

S

Update
Property name Possible values Default value method Notes
AdapterHelpName One of the valid Template name, if valid, | Component Supported regional
subdirectories in or blank field restart settings.
<ProductDir>\bin\Data Include chs_chn,
\App\Help\ that cht_twn, deu_deu,
contains a valid esn_esp, fra_fra,
<RegionalSetting> ita_ita, jpn_jpn,
directory kor_kor, ptb_bra,
and enu_usa (default).
AdminInQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/ADMININQUEUE restart only when the value
of DeliveryTransport
is JMS
AdminOutQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/ADMINOUTQUEUE restart only when the value
of DeliveryTransport
is JMS
AgentConnections 1 through 4 1 Component This property is valid
restart only when the value
of DeliveryTransport
is MQ or IDL, the value
of Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
AgentTraceLevel 0 through 5 0 Dynamic
if broker is
ICS;
otherwise
Component
restart
ApplicationName Application name The value specified for | Component
the connector restart
application name
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Table 11. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
BiDi.Application Any valid combination ILYNN (five letters) Component This property is valid
of these bidirectional restart only if the value
attributes: of BiDi.Transforma tion
is true
1st letter: I,V
2nd letter: L,R
3rd letter: Y, N
4th letter: S, N
5th letter: H, C, N
BiDi.Broker Any valid combination ILYNN (five letters) Component This property is valid
of these bidirectional restart only if the value of
attributes: BiDi.Transformation
is true. If the value of
1st letter: I,V BrokerType is
2nd letter: L,R 'ICS, the property
3rd letter: Y, N is read-only.
4th letter: S, N
5th letter: H, C, N
BiDi.Metadata Any valid combination ILYNN (five letters) Component This property is valid
of these bidirectional restart only if the value of
attributes: BiDi.Transformation
is true.
Ist letter: I,V
2nd letter: L,R
3rd letter: Y, N
4th letter: S, N
5th letter: H, C, N
BiDi.Transformation true or false false Component This property is valid
restart only if the value of
BrokerType is not WAS.
BOTrace none or keys or full none Agent This property is valid
restart only if the value of
AgentTraceLevel is
lower than 5.
BrokerType ICS, WMQI, WAS ICS Component
restart
CharacterEncoding Any supported code. ascii7 Component This property is valid
The list shows this subset: restart only for C++ connectors.
ascii7, ascii8, SJIS,
Cp949, GBK, Big5,
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
CommonkEventInfrastruc true or false false Component
ture restart
CommonEventInfrastruc A URL string, for No default value. Component This property is valid
tureURL example, restart only if the value of
corbaloc:iiop: CommonEvent
host:2809. Infrastructure is true.
ConcurrentEventTrig 1 through 32,767 1 Component This property is valid
geredFlows restart only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is ICS.
ContainerManagedEvents | Blank or JMS Blank Component This property is valid
restart only when the value

of Delivery Transport
is JMS.
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Table 11. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update
method

Notes

ControllerEventSequenc
ing

true or false

true

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

ControllerStoreAndFor
wardMode

true or false

true

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

ControllerTraceLevel

0 through 5

Dynamic

This property is valid
only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is ICS.

DeliveryQueue

Any valid JMS
queue name

<CONNECTORNAME>
/DELIVERYQUEUE

Component
restart

This property is valid
only when the value
of Delivery Transport
is JMS.

DeliveryTransport

MQ, IDL, or JMS

IDL when the value of
RepositoryDirectory is
<REMOTE>, otherwise
JMS

Component
restart

If the value of
RepositoryDirectory is
not <REMOTE>,

the only valid value for

this property is JMS.

DuplicateEventElimina
tion

true or false

false

Component
restart

This property is valid
only if the value of

DeliveryTransport is JMS.

EnableOidForFlowMoni
toring

true or false

false

Component
restart

This property is valid
only if the value of
BrokerType is ICS.

FaultQueue

Any valid queue name.

<CONNECTORNAME>
/FAULTQUEUE

Component
restart

This property is

valid only if the value

of DeliveryTransport
is JMS.

jms.FactoryClassName

CxCommon.Messaging. jms
. IBMMQSeriesFactory,
CxCommon.Messaging
.Jms.SonicMQFactory,
or any Java class name

CxCommon.Messaging.
jms.IBMMQSeriesFactory

Component
restart

This property is

valid only if the value

of DeliveryTransport
is JMS.

jms.ListenerConcurrency

1 through 32767

Component
restart

This property is

valid only if the value of
jms.TransportOptimized

is true.

jms.MessageBrokerName

If the value of
jms.FactoryClassName
is IBM, use
crossworlds.queue.
manager.

crossworlds.queue.
manager

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS

jms.NumConcurrent
Requests

Positive integer

10

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS
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Table 11. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
jms.Password Any valid password Component This property is valid
restart only if the value of
DeliveryTransport
is JMS
jms.TransportOptimized true or false false Component This property is valid
restart only if the value of
DeliveryTransport
is JMS and the value of
BrokerType is ICS.
jms.UserName Any valid name Component This property is valid
restart only if the value of
Delivery Transport is JMS.
JvmMaxHeapSize Heap size in megabytes 128m Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
JvmMaxNativeStackSize Size of stack in kilobytes 128k Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
JvmMinHeapSize Heap size in megabytes Im Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
ListenerConcurrency 1 through 100 1 Component This property is valid
restart only if the value of
DeliveryTransport is MQ.
Locale This is a subset of the en_US Component
supported locales: restart
en_US, ja_JP, ko KR,
zh_CN, zh_TW, fr_FR,
de DE, it_IT,
es_ES, pt_BR
LogAtInterchangeEnd true or false false Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
MaxEventCapacity 1 through 2147483647 2147483647 Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
MessageFileName Valid file name InterchangeSystem.txt Component
restart
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Table 11. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
MonitorQueue Any valid queue name <CONNECTORNAME> Component This property is valid
/MONITORQUEUE restart only if the value of
DuplicateEventElimination
is true and
ContainerManagedEvents
has no value.
OADAutoRestartAgent true or false false Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
OADMaxNumRetry A positive integer 1000 Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
OADRetryTimelnterval A positive integer 10 Dynamic This property is valid
in minutes only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
PollEndTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
PollFrequency A positive integer 10000 Dynamic
(in milliseconds) if broker is
ICS;
otherwise
Component
restart
PollQuantity 1 through 500 1 Agent restart | This property is valid
only if the value of
ContainerManagedEvents
is JMS.
PollStartTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
RepositoryDirectory <REMOTE> if the broker |For ICS, the value is set | Agent restart
is ICS; otherwise any to <REMOTE>
valid local directory.
For WMQI and WAS,
the value is
<ProductDir
\repository
RequestQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/REQUESTQUEUE restart only if the value of
DeliveryTransport
is JMS
ResponseQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/RESPONSEQUEUE restart only if the value of
DeliveryTransport is JMS.
RestartRetryCount 0 through 99 7 Dynamic
if ICS;
otherwise
Component
restart
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Table 11. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
RestartRetryInterval A value in minutes 1 Dynamic
from 1 through if ICS;
2147483647 otherwise
Component
restart
ResultsSetEnabled true or false false Component Used only by connectors
restart that support DB2IIL.
This property is valid
only if the value of
DeliveryTransport
is JMS, and the value of
BrokerType is WMQI.
ResultsSetSize Positive integer 0 (means the results Component Used only by connectors
set size is unlimited) restart that support DB2II.
This property is valid
only if the value of
ResultsSetEnabled
is true.
RHF2MessageDomain mrm or xml mrm Component This property is valid
restart only if the value
of DeliveryTransport
is JMS and the value of
WireFormat is CwXML.
SourceQueue Any valid WebSphere <CONNECTORNAME> Agent restart | This property is valid
MQ queue name /SOURCEQUEUE only if the value of
ContainerManagedEvents
is JMS.
SynchronousRequest Any valid queue name. <CONNECTORNAME> Component This property is valid
Queue /SYNCHRONOUSREQUEST restart only if the value
QUEUE of DeliveryTransport
is JMS.
SynchronousRequest 0 to any number 0 Component This property is valid
Timeout (milliseconds) restart only if the value
of DeliveryTransport
is JMS.
SynchronousResponse Any valid queue name <CONNECTORNAME> Component This property is valid
Queue /SYNCHRONOUSRESPONSE restart only if the value
QUEUE of DeliveryTransport
is JMS.
TivoliMonitorTransaction true or false false Component
Performance restart
WireFormat CwXML or CwBO CwXML Agent restart | The value of this
property must be CwXML
if the value
of RepositoryDirectory
is not set to <REMOTE>.
The value must
be CwBO if the value of
RepositoryDirectory is set
to <REMOTE>.
WsifSynchronousRequest 0 to any number 0 Component This property is valid
Timeout (milliseconds) restart only if the value of

BrokerType is WAS.
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Table 11. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update
method

Notes

XMLNameSpaceFormat

short or Tong or no

short

Agent restart

This property is valid
only if the value of
BrokerType is

WMQI or WAS

Standard properties

This section describes the standard connector configuration properties.

AdapterHelpName

The AdapterHelpName property is the name of a directory in which
connector-specific extended help files are located. The directory must be located in
<ProductDir>\bin\Data\ App\Help and must contain at least the language
directory enu_usa. It may contain other directories according to locale.

The default value is the template name if it is valid, or it is blank.

AdminIinQueue

The AdminInQueue property specifies the queue that is used by the integration

broker to send administrative messages to the connector.

The default value is <CONNECTORNAME>/ADMININQUEUE

AdminOutQueue

The AdminOutQueue property specifies the queue that is used by the connector to
send administrative messages to the integration broker.

AgentConnections

The default value is <CONNECTORNAME>/ADMINOUTQUEUE

The AgentConnections property controls the number of ORB (Object Request
Broker) connections opened when the ORB initializes.

It is valid only if the value of the RepositoryDirectory is set to <REMOTE> and the
value of the DeliveryTransport property is MQ or IDL.

The default value of this property is 1.

AgentTraceLevel

The AgentTraceLevel property sets the level of trace messages for the
application-specific component. The connector delivers all trace messages

applicable at the tracing level set and lower.

The default value is 0.
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ApplicationName

The ApplicationName property uniquely identifies the name of the connector
application. This name is used by the system administrator to monitor the
integration environment. This property must have a value before you can run the
connector.

The default is the name of the connector.

BiDi.Application
The BiDi.Application property specifies the bidirectional format for data coming
from an external application into the adapter in the form of any business object
supported by this adapter. The property defines the bidirectional attributes of the
application data. These attributes are:

* Type of text: implicit or visual (I or V)

* Text direction: left-to-right or right-to-left (L or R)

* Symmetric swapping: on or off (Y or N)

* Shaping (Arabic): on or off (S or N)

* Numerical shaping (Arabic): Hindi, contextual, or nominal (H, C, or N)

This property is valid only if the BiDi.Transformation property value is set to true.

The default value is ILYNN (implicit, left-to-right, on, off, nominal).

BiDi.Broker

The BiDi.Broker property specifies the bidirectional script format for data sent from
the adapter to the integration broker in the form of any supported business object.
It defines the bidirectional attributes of the data, which are as listed under
BiDi.Application above.

This property is valid only if the BiDi.Transformation property value is set to true.
If the BrokerType property is ICS, the property value is read-only.

The default value is ILYNN (implicit, left-to-right, on, off, nominal).

BiDi.Metadata

The BiDi.Metadata property defines the bidirectional format or attributes for the
metadata, which is used by the connector to establish and maintain a link to the
external application. The attribute settings are specific to each adapter using the
bidirectional capabilities. If your adapter supports bidirectional processing, refer to
the section on adapter-specific properties for more information.

This property is valid only if the BiDi.Transformation property value is set to true.

The default value is ILYNN (implicit, left-to-right, on, off, nominal).

BiDi.Transformation

The BiDi.Transformation property defines whether or not the system performs a
bidirectional transformation at run time.

If the property value is set to true, the BiDi.Application, BiDi.Broker, and

BiDi.Metadata properties are available. If the property value is set to false, they
are hidden.
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The default value is false.

BOTrace

The BOTrace property specifies whether or not business object trace messages are
enabled at run time.

Note: It applies only when the AgentTraceLevel property is set to less than 5.

When the trace level is set to less than 5, you can use these command line
parameters to reset the value of BOTrace.

* Enter -xBOTrace=Full to dump all the business object’s attributes.
* Enter -xBOTrace=Keys to dump only the business object’s keys.
* Enter -xBOTrace=None to disable business object attribute dumping.

The default value is false.

BrokerType

The BrokerType property identifies the integration broker type that you are using.
The possible values are ICS, WMQI (for WMQI, WMQIB or WBIMB), or WAS.

CharacterEncoding

The CharacterEncoding property specifies the character code set used to map from
a character (such as a letter of the alphabet, a numeric representation, or a
punctuation mark) to a numeric value.

Note: Java-based connectors do not use this property. C++ connectors use the
value ascii7 for this property.

By default, only a subset of supported character encodings is displayed. To add
other supported values to the list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory (<ProductDir>). For
more information, see the Connector Configurator appendix in this guide.

CommonEventinfrastructure

The Common Event Infrastructure (CEI) is a simple event management function
handling generated events. The CommonEventInfrastructure property specifies
whether the CEI should be invoked at run time.

The default value is false.

CommonEventinfrastructureContextURL

The CommonEventInfrastructureContextURL is used to gain access to the WAS
server that executes the Common Event Infrastructure (CEI) server application.
This property specifies the URL to be used.

This property is valid only if the value of CommonEventInfrastructure is set to
true.

The default value is a blank field.
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ConcurrentEventTriggeredFlows

The ConcurrentEventTriggeredFlows property determines how many business
objects can be concurrently processed by the connector for event delivery. You set
the value of this attribute to the number of business objects that are mapped and
delivered concurrently. For example, if you set the value of this property to 5, five
business objects are processed concurrently.

Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), the following properties must configured:

* The collaboration must be configured to use multiple threads by setting its
Maximum number of concurrent events property high enough to use multiple
threads.

¢ The destination application’s application-specific component must be configured
to process requests concurrently. That is, it must be multithreaded, or it must be
able to use connector agent parallelism and be configured for multiple processes.
The Parallel Process Degree configuration property must be set to a value larger
than 1.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and is performed serially.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1.

ContainerManagedEvents

The ContainerManagedEvents property allows a JMS-enabled connector with a
JMS event store to provide guaranteed event delivery, in which an event is
removed from the source queue and placed on the destination queue as one JMS
transaction.

When this property is set to JMS, the following properties must also be set to
enable guaranteed event delivery:

* PollQuantity = 1 to 500
* SourceQueue = /SOURCEQUEUE

You must also configure a data handler with the MimeType and DHClass (data
handler class) properties. You can also add DataHandlerConfigMOName (the
meta-object name, which is optional). To set those values, use the Data Handler
tab in Connector Configurator.

Although these properties are adapter-specific, here are some example values:
* MimeType = text\xml

* DHClass = com.crossworlds.DataHandlers.text.xml

* DataHandlerConfigMOName = MO_DataHandler_Default
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The fields for these values in the Data Handler tab are displayed only if you have
set the ContainerManagedEvents property to the value JMS.

Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pollForEvents() method, thereby disabling that method’s functionality.

The ContainerManagedEvents property is valid only if the value of the
DeliveryTransport property is set to JMS.

There is no default value.

ControllerEventSequencing

The ControllerEventSequencing property enables event sequencing in the connector
controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE> (BrokerType is ICS).

The default value is true.

ControllerStoreAndForwardMode

The ControllerStoreAndForwardMode property sets the behavior of the connector
controller after it detects that the destination application-specific component is
unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches ICS, the connector controller blocks the request
to the application-specific component. When the application-specific component
becomes operational, the controller forwards the request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific

component is unavailable.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE> (the value of the BrokerType property is ICS).

The default value is true.

ControllerTraceLevel

The ControllerTraceLevel property sets the level of trace messages for the
connector controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE>.

The default value is 0.
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DeliveryQueue

The DeliveryQueue property defines the queue that is used by the connector to
send business objects to the integration broker.

This property is valid only if the value of the DeliveryTransport property is set to
JMS.

The default value is <CONNECTORNAME>/DELIVERYQUEUE.

DeliveryTransport

The DeliveryTransport property specifies the transport mechanism for the delivery
of events. Possible values are MQ for WebSphere MQ, IDL for CORBA IIOP, or JMS
for Java Messaging Service.

e If the value of the RepositoryDirectory property is set to <REMOTE>, the value
of the DeliveryTransport property can be MQ, IDL, or JMS, and the default is IDL.

e If the value of the RepositoryDirectory property is a local directory, the value
can be only JMS.

The connector sends service-call requests and administrative messages over
CORBA 1IIOP if the value of the RepositoryDirectory property is MQ or IDL.

If the value of the DeliveryTransport property is MQ, you can set the command-line
parameter WhenServerAbsent in the adapter start script to indicate whether the
adapter should pause or shut down when the InterChange Server is shut down.

* Enter WhenServerAbsent=pause to pause the adapter when ICS is not available.

* Enter WhenServerAbsent=shutdown to shut down the adapter when ICS is not
available.

WebSphere MQ and IDL

Use WebSphere MQ rather than IDL for event delivery transport, unless you must
have only one product. WebSphere MQ offers the following advantages over IDL:

¢ Asynchronous communication:
WebSphere MQ allows the application-specific component to poll and
persistently store events even when the server is not available.

* Server side performance:
WebSphere MQ provides faster performance on the server side. In optimized
mode, WebSphere MQ stores only the pointer to an event in the repository
database, while the actual event remains in the WebSphere MQ queue. This
prevents writing potentially large events to the repository database.

* Agent side performance:
WebSphere MQ provides faster performance on the application-specific
component side. Using WebSphere MQ), the connector polling thread picks up an
event, places it in the connector queue, then picks up the next event. This is
faster than IDL, which requires the connector polling thread to pick up an event,
go across the network into the server process, store the event persistently in the
repository database, then pick up the next event.

JMS

The JMS transport mechanism enables communication between the connector and
client connector framework using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as
jms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName
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are listed in Connector Configurator. The properties jms.MessageBrokerName and
jms.FactoryClassName are required for this transport.

There may be a memory limitation if you use the JMS transport mechanism for a
connector in the following environment:

¢ AIX 5.0
* WebSphere MQ 5.3.0.1
 ICS is the integration broker

In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client. If your installation uses less than 768MB of
process heap size, set the following variable and property:

* Set the LDR_CNTRL environment variable in the CWSharedEnv.sh script.

This script is located in the \bin directory below the product directory
(<ProductDir>). Using a text editor, add the following line as the first line in the
CWSharedEnv.sh script:

export LDR_CNTRL=MAXDATA=0x30000000

This line restricts heap memory usage to a maximum of 768 MB (3 segments *
256 MB). If the process memory grows larger than this limit, page swapping can
occur, which can adversely affect the performance of your system.

* Set the value of the IPCCBaseAddress property to 11 or 12. For more
information on this property, see the System Installation Guide for UNIX.

DuplicateEventElimination

When the value of this property is true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, during
connector development, the connector must have a unique event identifier set as
the business object ObjectEventld attribute in the application-specific code.

Note: When the value of this property is true, the MonitorQueue property must
be enabled to provide guaranteed event delivery.

The default value is false.

EnableOidForFlowMonitoring

When the value of this property is true, the adapter runtime will mark the
incoming ObjectEventID as a foreign key for flow monitoring.

This property is only valid if the BrokerType property is set to ICS.

The default value is false.

FaultQueue

If the connector experiences an error while processing a message, it moves the
message (and a status indicator and description of the problem) to the queue
specified in the FaultQueue property.

The default value is <CONNECTORNAME>/FAULTQUEUE.
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jms.FactoryClassName

The jms.FactoryClassName property specifies the class name to instantiate for a
JMS provider. This property must be set if the value of the DeliveryTransport
property is JMS.

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.

jms.ListenerConcurrency

The jms.ListenerConcurrency property specifies the number of concurrent listeners
for the JMS controller. It specifies the number of threads that fetch and process
messages concurrently within a controller.

This property is valid only if the value of the jms.OptimizedTransport property is
true.

The default value is 1.

jms.MessageBrokerName

The jms.MessageBrokerName specifies the broker name to use for the J]MS
provider. You must set this connector property if you specify JMS as the delivery
transport mechanism (in the DeliveryTransport property).

When you connect to a remote message broker, this property requires the following
values:

QueueMgrName :Channel : Hos tName : PortNumber

where:

QueueMgrhName is the name of the queue manager.

Channel is the channel used by the client.

HostName is the name of the machine where the queue manager is to reside.
PortNumberis the port number used by the queue manager for listening

For example:
jms.MessageBrokerName = WBIMB.Queue.Manager:CHANNEL1:RemoteMachine:1456

The default value is crossworlds.queue.manager. Use the default when connecting
to a local message broker.

jms.NumConcurrentRequests

The jms.NumConcurrentRequests property specifies the maximum number of
concurrent service call requests that can be sent to a connector at the same time.
Once that maximum is reached, new service calls are blocked and must wait for
another request to complete before proceeding.

The default value is 10.

jms.Password

The jms.Password property specifies the password for the JMS provider. A value
for this property is optional.

There is no default value.
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jms.TransportOptimized

The jms.TransportOptimized property determines if the WIP (work in progress) is
optimized. You must have a WebSphere MQ provider to optimize the WIP. For
optimized WIP to operate, the messaging provider must be able to:

1. Read a message without taking it off the queue

2. Delete a message with a specific ID without transferring the entire message to
the receiver’s memory space

3. Read a message by using a specific ID (needed for recovery purposes)

4. Track the point at which events that have not been read appear.

The JMS APIs cannot be used for optimized WIP because they do not meet
conditions 2 and 4 above, but the MQ Java APIs meet all four conditions, and

hence are required for optimized WIP.

This property is valid only if the value of DeliveryTransport is JMS and the value of
BrokerType is ICS.

The default value is false.

jms.UserName

the jms.UserName property specifies the user name for the J]MS provider. A value
for this property is optional.

There is no default value.

JvmMaxHeapSize

The JvmMaxHeapSize property specifies the maximum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128m.

JvmMaxNativeStackSize

The JvmMaxNativeStackSize property specifies the maximum native stack size for
the agent (in kilobytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128k.

JvmMinHeapSize

The JvmMinHeapSize property specifies the minimum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1m.
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ListenerConcurrency

The ListenerConcurrency property supports multithreading in WebSphere MQ
Listener when ICS is the integration broker. It enables batch writing of multiple
events to the database, thereby improving system performance.

This property valid only with connectors that use MQ transport. The value of the
DeliveryTransport property must be MQ.

The default value is 1.

Locale

The Locale property specifies the language code, country or territory, and,
optionally, the associated character code set. The value of this property determines
cultural conventions such as collation and sort order of data, date and time
formats, and the symbols used in monetary specifications.

A locale name has the following format:
Ul _TT.codeset

where:

Il is a two-character language code (in lowercase letters)

TT is a two-letter country or territory code (in uppercase letters)

codeset is the name of the associated character code set (may be optional).

By default, only a subset of supported locales are listed. To add other supported
values to the list, you modify the \Data\Std\stdConnProps.xml file in the
<ProductDir>\bin directory. For more information, refer to the Connector
Configurator appendix in this guide.

If the connector has not been internationalized, the only valid value for this
property is en_US. To determine whether a specific connector has been globalized,
refer to the user guide for that adapter.

The default value is en_US.

LogAtinterchangeEnd

The LogAtInterchangeEnd property specifies whether to log errors to the log
destination of the integration broker.

Logging to the log destination also turns on e-mail notification, which generates
e-mail messages for the recipient specified as the value of MESSAGE_RECIPIENT
in the InterchangeSystem.cfg file when errors or fatal errors occur. For example,
when a connector loses its connection to the application, if the value of
LogAtInterChangeEnd is true, an e-mail message is sent to the specified message
recipient.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is false.

MaxEventCapacity

The MaxEventCapacity property specifies maximum number of events in the
controller buffer. This property is used by the flow control feature.
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This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The value can be a positive integer between 1 and 2147483647.

The default value is 2147483647.

MessageFileName

The MessageFileName property specifies the name of the connector message file.
The standard location for the message file is \connectors\messages in the product
directory. Specify the message file name in an absolute path if the message file is
not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a connector has its own message file, see the
individual adapter user guide.

The default value is InterchangeSystem.txt.

MonitorQueue

The MonitorQueue property specifies the logical queue that the connector uses to
monitor duplicate events.

It is valid only if the value of the DeliveryTransport property is JMS and the value
of the DuplicateEventElimination is true.

The default value is <CONNECTORNAME>/MONITORQUEUE

OADAutoRestartAgent

the OADAutoRestartAgent property specifies whether the connector uses the
automatic and remote restart feature. This feature uses the WebSphere
MQ-triggered Object Activation Daemon (OAD) to restart the connector after an
abnormal shutdown, or to start a remote connector from System Monitor.

This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the WebSphere MQ-triggered OAD
feature. see the Installation Guide for Windows or for UNIX.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is false.

OADMaxNumRetry

The OADMaxNumRetry property specifies the maximum number of times that the
WebSphere MQ-triggered Object Activation Daemon (OAD) automatically attempts
to restart the connector after an abnormal shutdown. The OADAutoRestartAgent
property must be set to true for this property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).
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The default value is 1000.

OADRetryTimelnterval

The OADRetryTimelnterval property specifies the number of minutes in the
retry-time interval for the WebSphere MQ-triggered Object Activation Daemon
(OAD). If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this
property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is 10.

PollEndTime

The PollEndTime property specifies the time to stop polling the event queue. The
format is HH:MM, where HH is O through 23 hours, and MY represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
¢ PollEndTime set and PollStartTime not set

it will poll using the value configured for the PollFrequency property.

PollFrequency

The PollFrequency property specifies the amount of time (in milliseconds) between
the end of one polling action and the start of the next polling action. This is not
the interval between polling actions. Rather, the logic is as follows:

* Poll to obtain the number of objects specified by the value of the PollQuantity
property.

* Process these objects. For some connectors, this may be partly done on separate
threads, which execute asynchronously to the next polling action.

* Delay for the interval specified by the PollFrequency property.
* Repeat the cycle.

The following values are valid for this property:
* The number of milliseconds between polling actions (a positive integer).

e The word no, which causes the connector not to poll. Enter the word in
lowercase.

¢ The word key, which causes the connector to poll only when you type the letter
p in the connector Command Prompt window. Enter the word in lowercase.

The default is 10000.

Important: Some connectors have restrictions on the use of this property. Where
they exist, these restrictions are documented in the chapter on
installing and configuring the adapter.

74 Adapter for Enterprise Java Beans Architecture User Guide



PollQuantity

The PollQuantity property designates the number of items from the application
that the connector polls for. If the adapter has a connector-specific property for
setting the poll quantity, the value set in the connector-specific property overrides
the standard property value.

This property is valid only if the value of the DeliveryTransport property is JMS,
and the ContainerManagedEvents property has a value.

An e-mail message is also considered an event. The connector actions are as
follows when it is polled for e-mail.

¢ When it is polled once, the connector detects the body of the message, which it
reads as an attachment. Since no data handler was specified for this mime type,
it will then ignore the message.

* The connector processes the first BO attachment. The data handler is available
for this MIME type, so it sends the business object to Visual Test Connector.

* When it is polled for the second time, the connector processes the second BO
attachment. The data handler is available for this MIME type, so it sends the
business object to Visual Test Connector.

* Once it is accepted, the third BO attachment should be transmitted.

PollStartTime

The PollStartTime property specifies the time to start polling the event queue. The
format is HH:MM, where HH is O through 23 hours, and MM represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
e PollEndTime set and PollStartTime not set

it will poll using the value configured for the PollFrequency property.

RepositoryDirectory

The RepositoryDirectory property is the location of the repository from which the
connector reads the XML schema documents that store the metadata for business
object definitions.

If the integration broker is ICS, this value must be set to set to <REMOTE>
because the connector obtains this information from the InterChange Server
repository.

When the integration broker is a WebSphere message broker or WAS, this value is

set to <ProductDir>\repository by default. However, it may be set to any valid
directory name.

RequestQueue

The RequestQueue property specifies the queue that is used by the integration
broker to send business objects to the connector.

This property is valid only if the value of the DeliveryTransport property is JMS.
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The default value is <CONNECTORNAME>/REQUESTQUEUE.

ResponseQueue

The ResponseQueue property specifies the JMS response queue, which delivers a
response message from the connector framework to the integration broker. When
the integration broker is ICS, the server sends the request and waits for a response
message in the JMS response queue.

This property is valid only if the value of the DeliveryTransport property is JMS.

The default value is <CONNECTORNAME>/RESPONSEQUEUE.

RestartRetryCount

The RestartRetryCount property specifies the number of times the connector
attempts to restart itself. When this property is used for a connector that is
connected in parallel, it specifies the number of times the master connector
application-specific component attempts to restart the client connector
application-specific component.

The default value is 7.

RestartRetryinterval

The RestartRetryInterval property specifies the interval in minutes at which the
connector attempts to restart itself. When this property is used for a connector that
is linked in parallel, it specifies the interval at which the master connector
application-specific component attempts to restart the client connector
application-specific component.

Possible values for the property range from 1 through 2147483647.

The default value is 1.

ResultsSetEnabled

The ResultsSetEnabled property enables or disables results set support when
Information Integrator is active. This property can be used only if the adapter
supports DB2 Information Integrator.

This property is valid only if the value of the DeliveryTransport property is JMS,
and the value of BrokerType is WMQI.

The default value is false.

ResultsSetSize
The ResultsSetSize property defines the maximum number of business objects that
can be returned to Information Integrator. This property can be used only if the
adapter supports DB2 Information Integrator.

This property is valid only if the value of the ResultsSetEnabled property is true.

The default value is 0. This means that the size of the results set is unlimited.
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RHF2MessageDomain

The RHF2MessageDomain property allows you to configure the value of the field
domain name in the JMS header. When data is sent to a WebSphere message
broker over JMS transport, the adapter framework writes JMS header information,
with a domain name and a fixed value of mrm. A configurable domain name lets
you track how the WebSphere message broker processes the message data.

This is an example header:

<mcd><Msd>mrm</Msd><Set>3</Set><Type>
Retek_POPhyDesc</Type><Fmt>CwXML</Fmt></mcd>

This property is valid only if the value of BrokerType is WMQI or WAS. Also, it is
valid only if the value of the DeliveryTransport property is JMS, and the value of
the WireFormat property is CwXML.

Possible values are mrm and xml. The default value is mrm.

SourceQueue

The SourceQueue property designates the JMS source queue for the connector
framework in support of guaranteed event delivery for [MS-enabled connectors

that use a JMS event store. For further information, see|“ContainerManagedEvents”]
i

This property is valid only if the value of DeliveryTransport is JMS, and a value for
ContainerManagedEvents is specified.

The default value is <CONNECTORNAME>/SOURCEQUEUE.

SynchronousRequestQueue

The SynchronousRequestQueue property delivers request messages that require a
synchronous response from the connector framework to the broker. This queue is
necessary only if the connector uses synchronous execution. With synchronous
execution, the connector framework sends a message to the synchronous request
queue and waits for a response from the broker on the synchronous response
queue. The response message sent to the connector has a correlation ID that
matches the ID of the original message.

This property is valid only if the value of DeliveryTransport is JMS.

The default value is <CONNECTORNAME>/SYNCHRONOUSREQUESTQUEUE

SynchronousRequestTimeout
The SynchronousRequestTimeout property specifies the time in milliseconds that
the connector waits for a response to a synchronous request. If the response is not
received within the specified time, the connector moves the original synchronous
request message (and error message) to the fault queue.
This property is valid only if the value of DeliveryTransport is JMS.

The default value is 0.
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SynchronousResponseQueue

The SynchronousResponseQueue property delivers response messages in reply to a
synchronous request from the broker to the connector framework. This queue is
necessary only if the connector uses synchronous execution.

This property is valid only if the value of DeliveryTransport is JMS.

The default is <CONNECTORNAME=>/SYNCHRONOUSRESPONSEQUEUE

TivoliMonitorTransactionPerformance

The TivoliMonitorTransactionPerformance property specifies whether IBM Tivoli
Monitoring for Transaction Performance (ITMTP) is invoked at run time.

The default value is false.

WireFormat

The WireFormat property specifies the message format on the transport:

* If the value of the RepositoryDirectory property is a local directory, the value is
CwXML.

¢ If the value of the RepositoryDirectory property is a remote directory, the value
is CwBO.

WsifSynchronousRequestTimeout
The WsifSynchronousRequestTimeout property specifies the time in milliseconds
that the connector waits for a response to a synchronous request. If the response is
not received within the specified time, the connector moves the original
synchronous request message (and an error message) to the fault queue.
This property is valid only if the value of BrokerType is WAS.

The default value is 0.

XMLNameSpaceFormat

The XMLNameSpaceFormat property specifies short or long namespaces in the
XML format of business object definitions.

This property is valid only if the value of BrokerType is set to WMQI or WAS.

The default value is short.
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Appendix B. Connector Configurator

This appendix describes how to use Connector Configurator to set configuration
property values for your adapter.

You use Connector Configurator to:

* Create a connector-specific property template for configuring your connector
* Create a configuration file

* Set properties in a configuration file

The topics covered in this appendix are:

* [“Overview of Connector Configurator” on page 79

+ |“Starting Connector Configurator” on page 80|

+ |“Creating a connector-specific property template” on page 81|

+ |“Creating a new configuration file” on page 84|

* |“Setting the configuration file properties” on page 87]

* [“Using Connector Configurator in a globalized environment” on page 95

Overview of Connector Configurator

Connector Configurator allows you to configure the connector component of your
adapter for use with these integration brokers:

* WebSphere InterChange Server (ICS)

* WebSphere MQ Integrator, WebSphere MQ Integrator Broker, and WebSphere
Business Integration Message Broker, collectively referred to as the WebSphere
Message Brokers (WMQI)

* WebSphere Application Server (WAS)

If your adapter supports DB2 Information Integrator, use the WMQI options and
the DB2 II standard properties (see the Notes column in the Standard Properties
appendix.)

You use Connector Configurator to:
* Create a connector-specific property template for configuring your connector.

* Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and, with ICS, maps for use with collaborations as well as specify
messaging, logging and tracing, and data handler parameters, as required.

The mode in which you run Connector Configurator, and the configuration file
type you use, may differ according to which integration broker you are running.
For example, if WMQI is your broker, you run Connector Configurator directly,
and not from within System Manager (see [“Running Configurator in stand-alone]

ode” on page 80).
pag
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Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator incorporates them into your
configuration file as soon as you create the file. However, you do need to set the
value of each standard property in Connector Configurator.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator will
show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties
and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 81to set up a new one.

Running connectors on UNIX

Connector Configurator runs only in a Windows environment. If you are running
the connector in a UNIX environment, use Connector Configurator in Windows to
modify the configuration file and then copy the file to your UNIX environment.

Some properties in the Connector Configurator use directory paths, which default
to the Windows convention for directory paths. If you use the configuration file in
a UNIX environment, revise the directory paths to match the UNIX convention for
these paths. Select the target operating system in the toolbar drop-list so that the
correct operating system rules are used for extended validation.

Starting Connector Configurator

You can start and run Connector Configurator in either of two modes:
* Independently, in stand-alone mode

e From System Manager

Running Configurator in stand-alone mode

You can run Connector Configurator without running System Manager and work
with connector configuration files, irrespective of your broker.

To do so:

* From Start>Programs, click IBM WebSphere Business Integration
Adapters>IBM WebSphere Business Integration Toolset>Connector
Configurator.

* Select File>New>Connector Configuration.

¢ When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS, WebSphere Message Brokers or WAS, depending on
your broker.

You may choose to run Connector Configurator independently to generate the file,
and then connect to System Manager to save it in a System Manager project (see
[“Completing a configuration file” on page 86l)
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Running Configurator from System Manager

You can run Connector Configurator from System Manager.

To run Connector Configurator:
1. Open the System Manager.

2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator. The
Connector Configurator window opens and displays a New Connector dialog
box.

4. When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS, WebSphere Message Brokers or WAS, depending on
your broker.

To edit an existing configuration file:

* In the System Manager window, select any of the configuration files listed in the
Connector folder and right-click on it. Connector Configurator opens and
displays the configuration file with the integration broker type and file name at
the top.

* From Connector Configurator, select File>Open. Select the name of the
connector configuration file from a project or from the directory in which it is
stored.

¢ Click the Standard Properties tab to see which properties are included in this
configuration file.

Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing connector definition as the template.

* To create a new template, see [‘Creating a new template” on page 81}

* To use an existing file, simply modify an existing template and save it under the
new name. You can find existing templates in your
\WebSphereAdapters\bin\Data\App directory.

Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template in Connector Configurator:
1. Click File>New>Connector-Specific Property Template.
2. The Connector-Specific Property Template dialog box appears.

¢ Enter a name for the new template in the Name field below Input a New
Template Name. You will see this name again when you open the dialog box
for creating a new configuration file from a template.
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* To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template appears in the Template Preview
display.

3. You can use an existing template whose property definitions are similar to
those required by your connector as a starting point for your template. If you
do not see any template that displays the connector-specific properties used by
your connector, you will need to create one.

 If you are planning to modify an existing template, select the name of the
template from the list in the Template Name table below Select the Existing
Template to Modify: Find Template.

¢ This table displays the names of all currently available templates. You can
also search for a template.

Specifying general characteristics

When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:

* General:
Property Type
Property Subtype
Updated Method
Description

* Flags
Standard flags

* Custom Flag
Flag

The Property Subtype can be selected when Property Type is a String. It is an
optional value which provides syntax checking when you save the configuration
file. The default is a blank space, and means that the property has not been
subtyped.

After you have made selections for the general characteristics of the property, click
the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1. Click the Value tab. The display panel for Value replaces the display panel for
General.

2. Select the name of the property in the Edit properties display.
3. In the fields for Max Length and Max Multiple Values, enter your values.

To create a new property value:
1. Right-click on the square to the left of the Value column heading.

2. From the pop-up menu, select Add to display the Property Value dialog box.
Depending on the property type, the dialog box allows you to enter either a
value, or both a value and a range.

3. Enter the new property value and click OK. The value appears in the Value
panel on the right.
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The Value panel displays a table with three columns:

The Value column shows the value that you entered in the Property Value dialog
box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value dialog
box.

After a value has been created and appears in the grid, it can be edited from
within the table display.

To make a change in an existing value in the table, select an entire row by clicking
on the row number. Then right-click in the Value field and click Edit Value.

Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Pol1Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventETimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1. In the Available Properties display, select the property that will be made
dependent.

2. In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

3. In the Condition Operator field, select one of the following:
== (equal to)
!= (not equal to)
> (greater than)
< (less than)
>= (greater than or equal to)
<=(less than or equal to)

4. In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

5. With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

6. Click Finish. Connector Configurator stores the information you have entered
as an XML document, under \data\app in the \bin directory where you have
installed Connector Configurator.

Setting pathnames
Some general rules for setting pathnames are:

* The maximum length of a filename in Windows and UNIX is 255 characters.

¢ In Windows, the absolute pathname must follow the format
[Drive:][Directory]\filename: for example,
C:\WebSphereAdapters\bin\Data\Std \StdConnProps.xml
In UNIX the first character should be /.
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* Queue names may not have leading or embedded spaces.

Creating a new configuration file

When you create a new configuration file, you must name it and select an
integration broker.

You also select an operating system for extended validation on the file. The toolbar
has a droplist called Target System that allows you to select the target operating
system for extended validation of the properties. The available options are:
Windows, UNIX, Other (if not Windows or UNIX), and None-no extended
validation (switches off extended validation). The default on startup is Windows.

To start Connector Configurator:

* In the System Manager window, select Connector Configurator from the Tools
menu. Connector Configurator opens.

* In stand-alone mode, launch Connector Configurator.

To set the operating system for extended validation of the configuration file:
* Pull down the Target System: droplist on the menu bar.
* Select the operating system you are running on.

Then select File>New>Connector Configuration. In the New Connector window,
enter the name of the new connector.

You also need to select an integration broker. The broker you select determines the
properties that will appear in the configuration file. To select a broker:

* In the Integration Broker field, select ICS, WebSphere Message Brokers or WAS
connectivity.

e Complete the remaining fields in the New Connector window, as described later
in this chapter.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

1. Set the operating system for extended validation of the configuration file using
the Target System: droplist on the menu bar (see “Creating a new configuration
file” above).

2. Click File>New>Connector Configuration.
3. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator does not check the spelling of the name
that you enter. You must ensure that the name is correct.

e System Connectivity
Click ICS or WebSphere Message Brokers or WAS.
* Select Connector-Specific Property Template
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Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

4. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector name. You can fill in all
the field values to complete the definition now, or you can save the file and
complete the fields later.

5. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running.
If you save as a file, the Save File Connector dialog box appears. Choose *.cfg
as the file type, verify in the File Name field that the name is spelled correctly
and has the correct case, navigate to the directory where you want to locate the
file, and click Save. The status display in the message panel of Connector
Configurator indicates that the configuration file was successfully created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

6. To complete the connector definition, enter values in the fields for each of the
tabs of the Connector Configurator window, as described later in this chapter.

Using an existing file

You may have an existing file available in one or more of the following formats:

* A connector definition file.
This is a text file that lists properties and applicable default values for a specific
connector. Some connectors include such a file in a \repository directory in
their delivery package (the file typically has the extension .txt; for example,
CN_XML.txt for the XML connector).

* An ICS repository file.
Definitions used in a previous ICS implementation of the connector may be
available to you in a repository file that was used in the configuration of that
connector. Such a file typically has the extension .in or .out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.

Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *.cfg, or *.in file from a directory:
1. In Connector Configurator, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

* Configuration (*.cfg)
* ICS Repository (*.1in, *.out)
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Choose this option if a repository file was used to configure the connector in
an ICS environment. A repository file may include multiple connector
definitions, all of which will appear when you open the file.

o All files (*.%)
Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,

select it, and click Open.

Follow these steps to open a connector configuration from a System Manager
project:

1.

Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator.

3. Click File>Open>From Project.

Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator window displays the configuration screen, with the current attributes
and values.

The title of the configuration screen displays the integration broker and connector
name as specified in the file. Make sure you have the correct broker. If not, change
the broker value before you configure the connector. To do so:

1.

Under the Standard Properties tab, select the value field for the BrokerType
property. In the drop-down menu, select the value ICS, WMQI, or WAS.

The Standard Properties tab will display the connector properties associated
with the selected broker. The table shows Property name, Value, Type, Subtype
(if the Type is a string), Description, and Update Method.

You can save the file now or complete the remaining configuration fields, as
described in [‘Specifying supported business object definitions” on page 89.

When you have finished your configuration, click File>Save>To Project or
File>Save>To File.

If you are saving to file, select *.cfg as the extension, select the correct location
for the file and click Save.

If multiple connector configurations are open, click Save All to File to save all
of the configurations to file, or click Save All to Project to save all connector
configurations to a System Manager project.

Before you created the configuration file, you used the Target System droplist
that allows you to select the target operating system for extended validation of
the properties.

Before it saves the file, Connector Configurator checks that values have been
set for all required standard properties. If a required standard property is
missing a value, Connector Configurator displays a message that the validation
failed. You must supply a value for the property in order to save the
configuration file.

If you have elected to use the extended validation feature by selecting a value
of Windows, UNIX or Other from the Target System droplist, the system will
validate the property subtype s well as the type, and it displays a warning
message if the validation fails.
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Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator displays a
configuration screen with tabs for the categories of required configuration values.

Connector Configurator requires values for properties in these categories for
connectors running on all brokers:

 Standard Properties

* Connector-specific Properties
* Supported Business Objects
* Trace/Log File values

¢ Data Handler (applicable for connectors that use JMS messaging with
guaranteed event delivery)

Note: For connectors that use JMS messaging, an additional category may display;,
for configuration of data handlers that convert the data to business objects.

For connectors running on ICS, values for these properties are also required:
* Associated Maps

* Resources

* Messaging (where applicable)

* Security

Important: Connector Configurator accepts property values in either English or
non-English character sets. However, the names of both standard and
connector-specific properties, and the names of supported business
objects, must use the English character set only.

Standard properties differ from connector-specific properties as follows:

* Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

* A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

* A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* Value fields are configurable.
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* The Update Method field is displayed for each property. It indicates whether a
component or agent restart is necessary to activate changed values. You cannot
configure this setting.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.

Note: If the property has a Type of String, it may have a subtype value in the
Subtype column. This subtype is used for extended validation of the
property.

3. After entering all the values for the standard properties, you can do one of the
following:

* To discard the changes, preserve the original values, and exit Connector
Configurator, click File>Exit (or close the window), and click No when
prompted to save changes.

* To enter values for other categories in Connector Configurator, select the tab
for the category. The values you enter for Standard Properties (or any other
category) are retained when you move to the next category. When you close
the window, you are prompted to either save or discard the values that you
entered in all the categories as a whole.

* To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

To get more information on a particular standard property, left-click the entry in
the Description column for that property in the Standard Properties tabbed sheet.
If you have Extended Help installed, an arrow button will appear on the right.
When you click on the button, a Help window will open and display details of the
standard property.

Note: If the hot button does not appear, no Extended Help was found for that
property.

If installed, the Extended Help files are located in
<ProductDir>\bin\Data\Std\Help\ <RegionalSetting>\.

Setting connector-specific configuration properties

For connector-specific configuration properties, you can add or change property

names, configure values, delete a property, and encrypt a property. The default

property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.

Note: If the property has a Type of String, you can select a subtype from the
Subtype droplist. This subtype is used for extended validation of the

property.
3. To encrypt a property, select the Encrypt box.
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4. To get more information on a particular property, left-click the entry in the
Description column for that property. If you have Extended Help installed, a
hot button will appear. When you click on the hot button, a Help window will
open and display details of the standard property.

Note: If the hot button does not appear, no Extended Help was found for that
property.
5. Choose to save or discard changes, as described for |“Setting standard connector]
[properties” on page 88)

If the Extended Help files are installed and the AdapterHelpName property is
blank, Connector Configurator will point to the adapter-specific Extended Help
files located in <ProductDir>\bin\Data\ App\Help\ <RegionalSetting>\. Otherwise,
Connector Configurator will point to the adapter-specific Extended Help files
located in
<ProductDir>\bin\Data\ App \Help\ <AdapterHelpName>\<RegionalSetting>\. See
the AdapterHelpName property described in the Standard Properties appendix.

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Connector-specific Properties window. To decrypt a value, click to clear
the Encrypt check box, enter the correct value in the Verification dialog box, and
click OK. If the entered value is correct, the value is decrypted and displays.

The adapter user guide for each connector contains a list and description of each
property and its default value.

If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method
Refer to the descriptions of update methods found in the Standard Properties
appendix, under [“Configuration property values overview” on page 56/

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator to specify the
business objects that the connector will use. You must specify both generic business
objects and application-specific business objects, and you must specify associations
for the maps between the business objects.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
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(using meta-objects) with their applications. For more information, see the
Connector Development Guide for C++ or the Connector Development Guide for
Java.

If ICS is your broker

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name: To designate that a business object definition is supported
by the connector, with System Manager running:

1. Click an empty field in the Business Object Name list. A drop list displays,
showing all the business object definitions that exist in the System Manager
project.

2. Click on a business object to add it.

3. Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator window, click Save to Project.
The revised connector definition, including designated support for the added
business object definition, is saved to an ICL (Integration Component Library)
project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator window, click Delete Row.
The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support: If a business object has Agent Support, the system will attempt to
use that business object for delivering data to an application via the connector
agent.

Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator window does not validate your
Agent Support selections.

Maximum transaction level: The maximum transaction level for a connector is
the highest transaction level that the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

If a WebSphere Message Broker is your broker
If you are working in stand-alone mode (not connected to System Manager), you
must enter the business object name manually.
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If you have System Manager running, you can select the empty box under the
Business Object Name column in the Supported Business Objects tab. A combo
box appears with a list of the business object available from the Integration
Component Library project to which the connector belongs. Select the business
object you want from the list.

The Message Set ID is an optional field for WebSphere Business Integration
Message Broker 5.0, and need not be unique if supplied. However, for WebSphere
MQ Integrator and Integrator Broker 2.1, you must supply a unique ID.

If WAS is your broker

When WebSphere Application Server is selected as your broker type, Connector
Configurator does not require message set IDs. The Supported Business Objects
tab shows a Business Object Name column only for supported business objects.

If you are working in stand-alone mode (not connected to System Manager), you
must enter the business object name manually.

If you have System Manager running, you can select the empty box under the
Business Object Name column in the Supported Business Objects tab. A combo box
appears with a list of the business objects available from the Integration
Component Library project to which the connector belongs. Select the business
object you want from this list.

Associated maps (ICS)

Each connector supports a list of business object definitions and their associated
maps that are currently active in WebSphere InterChange Server. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:
* Business Object Name

These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator window.

* Associated Maps
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The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit Binding
In some cases, you may need to explicitly bind an associated map.

Explicit binding is required only when more than one map exists for a particular
supported business object. When ICS boots, it tries to automatically bind a map
to each supported business object for each connector. If more than one map
takes as its input the same business object, the server attempts to locate and
bind one map that is the superset of the others.

If there is no map that is the superset of the others, the server will not be able to

bind the business object to a single map, and you will need to set the binding

explicitly.

To explicitly bind a map:

1. In the Explicit column, place a check in the check box for the map you want
to bind.

2. Select the map that you intend to associate with the business object.

3. In the File menu of the Connector Configurator window, click Save to
Project.

4. Deploy the project to ICS.
5. Reboot the server for the changes to take effect.

Resources (ICS)

The Resource tab allows you to set a value that determines whether and to what
extent the connector agent will handle multiple processes concurrently, using
connector agent parallelism.

Not all connectors support this feature. If you are running a connector agent that
was designed in Java to be multi-threaded, you are advised not to use this feature,
since it is usually more efficient to use multiple threads than multiple processes.

Messaging (ICS)

The Messaging tab enables you to configure messaging properties. The messaging
properties are available only if you have set MQ as the value of the
DeliveryTransport standard property and ICS as the broker type. These properties
affect how your connector will use queues.

Validating messaging queues
Before you can validate a messaging queue, you must:

* Make sure that WebSphere MQ Series is installed.
* Create a messaging queue with channel and port on the host machine.
* Set up a connection to the host machine.

To validate the queue, use the Validate button to the right of the Messaging Type
and Host Name fields on the Messaging tab.

Security (ICS)

You can use the Security tab in Connector Configurator to set various privacy
levels for a message. You can only use this feature when the DeliveryTransport
property is set to JMS.
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By default, Privacy is turned off. Check the Privacy box to enable it.

The Keystore Target System Absolute Pathname is:

e For Windows:
<ProductDir>\connectors\security\<connectorname>.jks

e For UNIX:
opt/IBM/WebSphereAdapters/connectors/security/<connectorname>. jks

This path and file should be on the system where you plan to start the connector,
that is, the target system.

You can use the Browse button at the right only if the target system is the one
currently running. It is greyed out unless Privacy is enabled and the Target System
in the menu bar is set to Windows.

The Message Privacy Level may be set as follows for the three messages categories
(All Messages, All Administrative Messages, and All Business Object Messages):

nrr

. is the default; used when no privacy levels for a message category have been
set.

* none
Not the same as the default: use this to deliberately set a privacy level of none
for a message category.

* integrity

* privacy

* integrity_plus_privacy

The Key Maintenance feature lets you generate, import and export public keys for
the server and adapter.

* When you select Generate Keys, the Generate Keys dialog box appears with the
defaults for the keytool that will generate the keys.

¢ The keystore value defaults to the value you entered in Keystore Target System
Absolute Pathname on the Security tab.

* When you select OK, the entries are validated, the key certificate is generated
and the output is sent to the Connector Configurator log window.

Before you can import a certificate into the adapter keystore, you must export it
from the server keystore. When you select Export Adapter Public Key, the Export
Adapter Public Key dialog box appears.

* The export certificate defaults to the same value as the keystore, except that the
file extension is <filename>.cer.

When you select Import Server Public Key, the Import Server Public Key dialog

box appears.

e The import certificate defaults to <ProductDir>\bin\ics.cer (if the file exists on
the system).

¢ The import Certificate Association should be the server name. If a server is
registered, you can select it from the droplist.

The Adapter Access Control feature is enabled only when the value of
DeliveryTransport is IDL. By default, the adapter logs in with the guest identity. If
the Use guest identity box is not checked, the Adapter Identity and Adapter
Password fields are enabled.
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Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator uses the logging and tracing values of that file as default
values. You can change those values in Connector Configurator.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

* To console (STDOUT):
Writes logging or tracing messages to the STDOUT display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

¢ To File:
Writes logging or tracing messages to a file that you specify. To specify the
file, click the directory button (ellipsis), navigate to the preferred location,
provide a file name, and click Save. Logging or tracing message are written
to the file and location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .1og and .txt are typical file extensions.

Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Not all adapters make use of data handlers.

See the descriptions under ContainerManagedEvents in Appendix A, Standard
Properties, for values to use for these properties. For additional details, see the
Connector Development Guide for C++ or the Connector Development Guide for Java.

Saving your configuration file

When you have finished configuring your connector, save the connector
configuration file. Connector Configurator saves the file in the broker mode that
you selected during configuration. The title bar of Connector Configurator always
displays the broker mode (ICS, WMQI or WAS) that it is currently using.

The file is saved as an XML document. You can save the XML document in three

ways:

* From System Manager, as a file with a *.con extension in an Integration
Component Library, or

* In a directory that you specify.

¢ In stand-alone mode, as a file with a *.cfg extension in a directory folder. By
default, the file is saved to \WebSphereAdapters\bin\Data\App.

* You can also save it to a WebSphere Application Server project if you have set
one up.

94 Adapter for Enterprise Java Beans Architecture User Guide



For details about using projects in System Manager, and for further information
about deployment, see the following implementation guides:

* For ICS: Implementation Guide for WebSphere InterChange Server

* For WebSphere Message Brokers: Implementing Adapters with WebSphere Message
Brokers

e For WAS: Implementing Adapters with WebSphere Application Server

Changing a configuration file

You can change the integration broker setting for an existing configuration file.
This enables you to use the file as a template for creating a new configuration file,
which can be used with a different broker.

Note: You will need to change other configuration properties as well as the broker
mode property if you switch integration brokers.

To change your broker selection within an existing configuration file (optional):

¢ Open the existing configuration file in Connector Configurator.

* Select the Standard Properties tab.

* In the BrokerType field of the Standard Properties tab, select the value that is
appropriate for your broker.
When you change the current value, the available tabs and field selections in the

properties window will immediately change, to show only those tabs and fields
that pertain to the new broker you have selected.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator in a globalized environment

Connector Configurator is globalized and can handle character conversion between
the configuration file and the integration broker. Connector Configurator uses
native encoding. When it writes to the configuration file, it uses UTF-8 encoding.

Connector Configurator supports non-English characters in:

+ All value fields

* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the

drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.

For example, to add the locale en_GB to the list of values for the Locale property,
open the stdConnProps.xml file and add the line in boldface type below:
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<Property name="Locale"

isRequired="true"

updateMethod="component restart">

<ValidType>String</ValidType>
<ValidValues>

<Value>ja_JP</Value>
<Value>ko_KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr FR</Value>
<Value>de_DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>

<DefaultValue>en_US</DefaultValue>
</ValidValues>
</Property>
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

577 Airport Blvd., Suite 800
Burlingame, CA 94010
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.
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If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:

i5/0S

IBM

the IBM logo
AIX

AIX 5L

CICS
CrossWorlds
DB2

DB2 Universal Database
Domino
HelpNow
IMS

Informix
iSeries

Lotus

Lotus Notes
MQIntegrator
MQSeries
MVS

Notes
0OS/400
Passport Advantage
pSeries
Redbooks
SupportPac
WebSphere
z/0S

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.
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Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product, or service names may be trademarks or service marks of
others.

This product includes software developed by the Eclipse Project
(http:/ /www.eclipse.org/).
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WebSphere Business Integration Adapters, Version 6.0

W

JAVA,
WebSphere Business Integration Adapter Framework V2.4.0
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